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1 Navisworks Manage File System

In this chapter:

Navisworks file types
Opening files directly
Exporting from Revit to Navisworks

Navisworks Appending and merging models
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1.1 Navisworks file types

Autodesk Navisworks has three native file formats: NWD, NWF, and NWC.

1.1.1 NWD File Format

An NWD file contains all model geometry together with Autodesk Navisworks-specific
data, such as review markups. You can think of an NWD file as a snapshot of the
current state of the model.

NWD files are very small, as they compress the CAD data by up to 80% of the original size.

1.1.2 NWF File Format

An NWF file contains links to the original native files (as listed on the Selection Tree)
together with Autodesk Navisworks-specific data, such as review markups. No model
geometry is saved with this file format; this makes an NWF considerably smaller in size
than an NWD.

1.1.3 NWC File Format (Cache Files)

By default, when you open or append any native CAD or laser scan files in
Autodesk Navisworks, a cache file is created in the same directory and with the
same name as the original file, but with an .nwc file extension.

NWC files are smaller than the original files, and speed up your access to commonly
used files. When you next open file or append file in Autodesk Navisworks, the data is
read from the corresponding cache file if it is newer than the original file. If the cache file
is older, which means the original file has changed, Autodesk Navisworks converts the
updated file, and creates a new cache file for it.

1.2 Opening files directly

In Autodesk Navisworks you can open files originated from a variety of CAD applications.

You can combine these files together, and create a single Autodesk Navisworks file

with a whole-project view of your model. This file brings together geometry and data
created by multi- disciplinary teams, and enables you to explore and review complex
models in real-time.

1.3 Exporting from Revit to Navisworks

Autodesk Navisworks can read native Revit (RVT) files directly. Alternatively, you can
use the file exporter to save your files in NWC format.

The file exporter is available for Revit 2018.

1.3.1 To export NWC files from Revit
1. In Revit, click Add-Ins External Tools Autodesk Navisworks.

Note: This option is not available in Demo/Viewer mode. If you are not in demo
mode, but do not have access to the Autodesk Navisworks menu, check if editing
view is set to normal, and the modify tool is selected ( Modify).

2. Inthe Export Scene As dialog box, enter the name for the Autodesk Navisworks
file, and browse to the desired storage location.

3. Click Save to export the file, or Cancel to return to the application without exporting it.
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1.3.2 To adjust the options for the Revit file exporter

—_

In Revit, click Add-Ins »External Tools »Autodesk Navisworks.
2. Inthe Export Scene As dialog box, click the Autodesk Navisworks Settings button.
3. Expand the File Exporters node in the Options Editor, and click the Revit
page. Use the options on this page to adjust the settings for future exports of
NWC files from Revit.
4. Click OK to save the changes and return to the Export Scene As dialog box.
5. Click Cancel to close the dialog box.

1.4 Appending and merging models

1.4.1 To append 3D models in a multi-sheet file
1. Open a multi-sheet file.
2. If the Sheet Browser window is not displayed, click on the Status bar.
3. Double-click the desired 3D model in the Sheet Browser to open it in the Scene View.
4. Use the Sheet Browser to select all 3D models that you want to append to the
currently open model.
Tip: To select multiple model, use SHIFT and CTRL keys.
5. Right-click the selection, and click Append to
Current Model. Note: The Undo command is not
available.

1.4.2 To merge files
1. Click New on the Quick Access toolbar.
Open the first of the files with the review markup.
Click Home tab Project panel Merge.
In the Merge dialog box, use the Files of Type box to select the appropriate
file type (NWD or NWF), and navigate to the folder where your files you
want to merge are located.
5. Select the required files, and click Open.
Tip: To select multiple files, use SHIFT and CTRL keys.Command entry: CTRL + M

rpOD
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2 Navigating in a Model

In this chapter:

Looking at the navigation bar

Rotating your model with the Orbit tool
Looking around your model

Using the Gravity tool

Using the ViewCube
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2.1 Looking at the navigation bar

The navigation bar is a user interface element where you can access both unified and product-
specific navigation tools.

Unified navigation tools (such as Autodesk® ViewCube®) are those that can be
found across many Autodesk products. Product-specific navigation tools are unique
to a product. The navigation bar floats over and along one of the sides of the Scene
View.

You start navigation tools by clicking one of the buttons on the navigation bar or
selecting one of the tools from a list that is displayed when you click the smaller portion
of a split button.

1. View Cube Indicates the current orientation of a model, and is used to
reorient the current view of a model. Clicking this button displays the View
Cube in the Scene View when it’s not visible.

2. Steering Wheels Collection of wheels that offer rapid switching between

specialized navigation tools.

Pan tool. Activates the pan tool and moves the view parallel to the screen.

4. Zoom tools. Set of navigation tools for increasing or decreasing the
magnification of the current view of the model.

5. Orbit tools. Set of navigation tools for rotating the model around a pivot point
while the view remains fixed.

6. Look tools. Set of navigation tools for rotating the current view
vertically and horizontally.

7. Walk and Fly tools. Set of navigation tools for moving around the model and
controlling realism settings.

8. Select tool. Geometry selection tool. You cannot navigate through your
model during geometry selection.

9. 3Dconnexion. Set of navigation tools used to reorient the current view of a
model with a 3Dconnexion 3D mouse.

Note: In a 2D workspace, only the 2D navigation tools (such as 2D Steering
Wheels, Pan, Zoom, and the 2D Mode 3Dconnexion tools) are accessible.

w

2.2 Walking through your model

Set of navigation tools for moving around the model and controlling realism
settings. These tools are not available in a 2D workspace.

The following tools are available:

e Walk. Moves through a model as if you were walking through it.
e Fly. Moves through a model like in a flight simulator.

2.1.1 Walk

The tool is activated by clicking Walk in the Walk/Fly drop-down on the navigation bar.
By default, the tool behaves like the Walk tool on the Steering Wheels. You can
customize the tool options in the Options Editor. You can also switch back to the
legacy Walk mode.

21.2 Fly
The tool is activated by clicking Fly in the Walk/Fly drop-down on the navigation bar.
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2.2 Rotating your model with the Orbit tool

Set of navigation tools for rotating the model around a pivot point while the view remains fixed.
These tools are not available in a 2D

workspace. The following orbit tools are
available:

¢ Orbit. Moves the camera around the focal point of the model. The up direction
isalways maintained, and no camera rolling is possible.

¢ Free Orbit. Rotates the model around the focal point in any direction.

e Constrained Orbit. Spins the model around the up vector as though the model
is sitting on a turntable. The up direction is always maintained.

2.2.1 Orbit

The tool is activated by clicking Orbit in the Orbit drop-down on the navigation bar. It
behaves the same way as the Orbit tool on the Steering Wheels. You can use the
Options Editor to switch back to the legacy Orbit mode.

2.2.2 Free Orbit
The tool is activated by clicking Free Orbit in the Orbit drop-down on the navigation
bar. You can use the Options Editor to switch back to the legacy Examine mode.

2.2.3 Constrained Orbit

The tool is activated by clicking Constrained Orbit in the Orbit drop-down on the
navigation bar. You can use the Options Editor to switch back to the legacy Turntable
mode.

2.3 Looking around your model

2.3.1 Pan Tool
The pan tool moves the view parallel to the screen.

The tool is activated by clicking Pan @ on the navigation bar. Pan behaves the same
way as the pan tool available on the Steering Wheels.

2.3.2 Look Tools
Set of navigation tools for rotating the current view vertically and horizontally. These
tools are not available in a 2D workspace.

The following look tools are available:

e Look Around (@ Looks around the scene from the current camera location.

e Look At @ Looks at a particular point in the scene. The camera moves to
align with that point.

&

where it is. Look Around

The tool is activated by clicking Look Around in the Look drop-down on the navigation bar. It
behaves the same way as the Look tool available on the Steering Wheels.

e Focus Looks at a particular point in the scene. The camera stays
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Look At
The tool is activated by clicking Look At in the Look drop-down on the navigation bar. It

behaves the same way as the Steering Wheels Look tool when you press and hold the
SHIFT key.

Focus
The tool is activated by clicking Focus in the Look drop-down on the navigation bar.

2.4 Using the Gravity tool

To toggle gravity

When using the Walk tool, click Viewpoint tab * Navigate panel » Realism drop-

A
»down Gravity check box.
Command entry: CTRL + G

Note: This function only works in connection with collision.
Where collision gives you mass, gravity gives you weight. As such, you (as the collision
volume) will be pulled downwards whilst walking through the scene.

Note: Gravity can only be used with the Walk navigation
tool. This allows you to walk down stairs, for example, or
follow terrain.

2.5 Using the ViewCube

The ViewCube tool is a persistent, clickable, and draggable interface that you use
to switch between views of your model.

When you display the ViewCube tool, by default it is shown in the top-right corner of
the Scene View over the model in an inactive state. The ViewCube tool provides visual
feedback about the current viewpoint of the model as view changes occur. When the
cursor is positioned over the ViewCube tool, it becomes active. You can drag or click
the ViewCube, switch to one of the available preset views, roll the current view, or
change to the Home view of the model.

dOL 0
LEFT

Figure 6-1 View Cube

Tip: When the navigation bar is linked to the ViewCube, both can be moved around
the Scene View.

2.5.1 Control the Appearance of ViewCube

The ViewCube tool is displayed in one of two states: inactive and active. When the
ViewCube tool is inactive, it appears partially transparent by default so that it does not
obscure the view of the model. When active, it is opaque and may obscure the view of
the objects in the current view of the model.
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In addition to controlling the opacity level of the ViewCube when it is inactive, you
can also control its size, and the display of the compass. The settings used to
control the appearance of the ViewCube are located in the Options Editor.

2.5.2 Use the Compass

The compass is displayed below the ViewCube tool and indicates which direction North
is defined for the model. You can click a cardinal direction letter on the compass to
rotate the model, or you can click and drag one of the cardinal direction letters or the
compass ring to interactively rotate the model around the pivot point.

P E
:

Figure 6-2 Compass View of View Cube

2.5.3 Drag or Click ViewCube

When you drag or click the ViewCube tool, the view of the model reorients around a
pivot point. The pivot point is displayed at the center of the object that was last
selected before using the ViewCube tool.
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3 Working with Viewpoints

In this chapter:
Saving a viewpoint
Choosing render styles
Changing the background
Slicing your model using sectioning

Getting rid of lines and text
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3.1 Saving a viewpoint

Viewpoints are snapshots taken of the model as it is displayed in the Scene View. They can be

taken by clicking the Save Viewpoint [©] button under the Viewpoint Tab. Importantly,
viewpoints can be used for more than just saving information about the view of the
model. For example, they can be annotated with redlines and comments, allowing you
to use viewpoints as a design review audit trail. Viewpoints can also be used as links in
the Scene View, so that when you click on and zoom to the viewpoint, Autodesk
Navisworks also displays the redlines and comments associated with it.

The viewpoints, redlines and comments are all saved into an NWF file from Autodesk
Navisworks, and are independent of the model geometry. So, if the native CAD files
are changing, the saved viewpoints remain the same, appearing as an overlay on top
of the base layer of model geometry. This enables you to see how the design has
evolved. See Review Your Model for more information on links, comments and
redlines and Native File Formats for more information on the NWF file format.

Viewpoints encompass a range of different information about the view of the model,
navigation settings, and annotations in the form of redlines and comments. See Default
Viewpoint Options for more information.

3.1.1 View of the Model
e Camera position, projection mode, field of view and orientation
e Lighting mode, render mode and toggles for the display of different
geometry types (surfaces, lines, points)
e Sectioning configuration

Additionally, the following item overrides can be saved with the viewpoint (this is optional):

e Visibility (hidden / required)
e Appearance (color and transparency)

3.1.2 Navigation
e Linear and angular speeds of motion
¢ Realism settings (collision, gravity, third person, crouch)
e The currently selected navigation tool

3.1.3 Annotations
¢ Redlines
e Comments

3.1.4 Saved Viewpoint Window

The Saved Viewpoints window is a dockable window that enables you to create and
manage different views of your model so that you can jump to preset viewpoints
without having to navigate each time to reach an item.

Viewpoint animations are also saved with the viewpoints, as they are simply a list of
viewpoints treated as keyframes. In fact, viewpoint animations can be made by
dragging preset viewpoints onto an empty viewpoint animation. You can organize your
viewpoints and viewpoint animations using folders.
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Icons are used to represent different elements:

G represents a folder which may contain all other elements (including other

@folders). represents a viewpoint saved in orthographic mode.
CDrepresents a viewpoint saved in

uperspeotive mode. represents a viewpoint

8‘<anima’[ion clip.

represents a cut inserted into a viewpoint animation clip.

You can select more than one viewpoint by either holding down the CTRL key and left-
clicking, or by left-clicking the first item, and then clicking the last item while holding
down the SHIFT key.

You can drag viewpoints around the Saved Viewpoints window, and reorganize
them into folders or animations.

There are no buttons on this window, and commands are invoked through context menus.

Through these menus, you can save and update viewpoints, create and manage
viewpoint animations, and create folders to organize these viewpoints and viewpoint
animations. You can also drag and drop viewpoints or viewpoint animations onto
viewpoint animations or folders.

Holding down the CTRL key during this operation will copy the element being
dragged. This allows complex hierarchies of viewpoint animations and folders to be
easily composed.

Viewpoints, folders and viewpoint animations can all be renamed by slow clicking
(clicking and pausing without moving the mouse) the element, or clicking it and
pressing F2.

Saved Viewpoints X I
#-(LJ 3D View
= u Animation
@ View
1) view (1)
@ View (2)
@ View (3)
1) view (4)

Figure 7-1: Saved Viewpoints Window

3.2 Choosing render styles

Use the Autodesk Rendering window to access and work with materials libraries,
lighting, and environment settings.
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The Autodesk Rendering window is a dockable window, which is used to set up
materials and lights in your scene, as well as environments settings, and render quality
and speed. It can be

A )
accessed by pressing the Autodesk Rendering & putton.

The Autodesk Rendering window contains the Rendering toolbar, and the following tabs:

Materials. Allows you to navigate and manage material collections, known as
libraries, provided by Autodesk, or create custom libraries for specific projects.
Default material library Includes a variety of materials, which can be selected
and applied to your model. You can also use this tab to create new materials,
or customize existing materials.

Material Mapping. Allows you to adjust the orientation of the texture to fit the
shape of the object. This feature is recommended for advanced users only.
Lighting. Allows you to view the lights already added to the model, and
customize the lighting properties.

Environments. Allows you to customize the Sun, the Sky, and Exposure properties.
Settings. Allows you to change the Render Style presets. You can select from
a range of default quality presets or customize your own render settings.

| Autodesk Rendering o x
\QQCreate Light ~ le"l lII Sun | & Exposure
| Materials | Material Mapping l Lighting l Environments l Settings
l:’f}’(' QI
Document Materials E i=-
Name ~ Category
Il Flat-Gray1 Concrete: Cast-In-Place
A v ) Autodesk Library ¥ E EE he
[ Autodesk Lib... 3 ~ Name ~ Category =
T
P Ceanic - 1.5in Square - Brown Ceramic: Tile
» T Concrete
T Default . 1.5in Square - Medium Blue = Ceramic: Tile
» Tl Fabric . 1.5in Square - Slate Blue Ceramic: Tile
" Finish . 1.5in Square - Tan Ceramic: Tile
» T Flooring . . i
» T Glass - 12in Non-Uni...r - Burgundy Masonry: Brick
Tl Liquid . 12in Running - Burgundy Masonry: Brick
» T Masonry Bl 12in Uniform...nning - Gray ~ Masonry: Brick
» T Metal B ins & =
T Metallic Paint I 1in Square - Ivory eramic: Tile
& Mirror i 1in Squares - Mosaic Blue Ceramic: Tile
@ Miscellaneous B 1in Squares - Mosaic Gray  Ceramic: Tile
ol |Point il 2ins Sal Ceramic: Til
T Plastic E in Square - Salmon eramic: Tile
T Roofing i 2in Squares - Beige Ceramic: Tile
" Siding M 3in Octagons - Tan Ceramic: Tile
Tl Sitework =
3in Octagons - White Ceramic: Tile
» M Stone S B d ==
T Stucco . 3in Square - Terra Cotta Ceramic: Tile
T Wall Covering I 3in Squares - Cozy Pink Ceramic: Tile
[ i _
Rttt {] 3in Squares - Light Yellow Ceramic: Tile
» T Wood —
»EJ Autodesk Ad... ~ W 3in Squares - White Ceramic: Tile =
Eg - B

Figure 7-2: Autodesk Rendering Window
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3.3 Changing the background
Use this dialog box to choose a background effect to use in the Scene View

3.3.1 Mode
Selects the type of background effect. Choose from:

e Plain

¢ Graduated

e Horizon

Note: Horizon mode and the associated colors are only available for 3D models.
3.3.2 Color

Sets the color for a plain background.

3.3.3 Top Color
Sets the top color in a graduated background.

3.3.4 Bottom Color
Sets the bottom color in the graduated background.

3.3.5 Sky Color
Sets the sky color (top) in a horizon background. This option is available for 3D models only.

3.3.6 Horizon Sky Color
Sets the sky color (bottom) in a horizon background. This option is available for 3D models only.

3.3.7 Horizon Ground Color
Sets the ground color (top) in a horizon background. This option is available for 3D models only.

3.3.8 Ground Color
Sets the ground color (bottom) in a horizon background. This option is available for
3D models only.

Ribbon: View tab »Scene View panel »Background =E]
Shortcut menu: Right-click a blank area in the scene, and click Background on
the context menu.

Figure 7-3: Backgrounds — Plain, Graduated, Horizon (Below Horizon)
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3.4 Slicing your model using sectioning

Autodesk Navisworks enables you to turn on sectioning for the current viewpoint and to
create cross sections of your model in a 3D workspace. The sectioning functionality is
not available for 2D sheets.

A cross section is a cut-away view of a 3D object that enable you to see inside it. You
can turn sectioning on and off for the current viewpoint by clicking Viewpoint tab »

Sectioning panel »Enable Sectioninglﬂzu. When the sectioning is turned on, the
Sectioning Tools contextual tab is automatically displayed on the ribbon.

There are two sectioning modes available from the Sectioning Tools tab »
Mode panel: Planes and Box.

Planes L[jmode allows you to make up to six sectional cuts in any plane while still
being able to navigate around the scene, enabling you to see inside models without
hiding any item. By default, section planes are created through the center of the visible
area of the model.

3.5 Getting rid of lines and text

3.5.1 To delete text
Right-click the text you want to delete, and click Delete Redline on the context menu.

3.5.2 To erase redlines
1. Click Viewpoint tab »Save, Load & Playback panel *»Saved Viewpoints
drop-down, and choose the viewpoint that you want to review.

y7,
2. Click Review tab »Redline panel 3Draw drop-down, and click Erase = ‘{
3. Drag a box over the redline you want to delete, and release the mouse.
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4 The Review Tab

In this chapter:

Getting measurements
Finding the shortest distance between objects

Creating redlines
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4.1 Getting measurements

To access the tools, click Review tab Measure panel on the ribbon.
411 Measure Tool

o =2 Measures the distance between two points.

<,

o ™ Measures the distance between a base point and various other points.

o ===Measures a total distance between multiple points along a route.

o——o
o—a

o ==% Calculates the sum total of several point-to-point measurements.

o ©==3(Calculates an angle between two lines.

o @=mCalculates an area on a plane.

e

o == Measures the shortest distance between two selected objects.
=R
o 8 Clears all measuring lines in the Scene View.

o 2 Enables you to move or rotate an object.

N Converts the endpoint markers, the lines, and any displayed
measurement values into redlines.

4.2 Finding the shortest distance between objects

Measure tools enable you to measure between points on items in the model. All
measurements are made in display units. The measure tools are available from
Review tab Measure panel.

Using measure tools is mutually exclusive to using navigation tools (see
Product-Specific Navigation Tools), so that when you are measuring you cannot
navigate and vice versa.

After selecting a measuring tool, select the points on the model that need to be
measured. Navisworks will then show the information it has collected from that
measurement.

Figure 4-1: Measure Tool

[wasasann)

To clear a measurement, select Clear Measurement *in the Measure Panel.
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4.3 Creating redlines

The Redline Tools panel on the Review tab enables you to markup viewpoints and clash results

with redline annotations. When you create a redline, the associated viewpoint is
automatically saved.

A Q /QColor B -

-

Draw Erase —Thlckness 3 2

-

Redline

Figure 4-2: Reline Panel

The Thickness and Color controls enable you to modify the redline settings. These
changes do not affect already drawn redlines. Also, thickness only applies to lines; it
does not affect redline text, which has a default size and weight and cannot be modified.

Figure 4-3: Redline Markup

You can also convert measurements to redlines with the Convert To Redline tool E]L'\ )
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5 Dealing with Objects

In this chapter:

Selecting objects

Ouverriding color, transparency, and a transform
Hiding and turning on objects

Moving items

Rotating items

Scaling items

Adding links

Viewing properties and adding fields

Switching back to Revit

Holding objects
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5.1 Selecting objects

With large models, it is potentially a very time-consuming process to select items of interest.
Autodesk Navisworks makes this a much simpler task by providing a range of

functions for quickly selecting geometry both interactively and by searching the

model manually and automatically.

9.1.1 Interactive Geometry Selection

In Autodesk Navisworks, there is a concept of an active selection set (the currently
selected items, or the current selection) and saved selections sets. Selecting and
finding items makes them part of the current selection, so you can hide them or
override their colors. At any time, the current selection can be saved and named for

retrieval in later sessions with the Save Selection [%] button.
Selecting items makes them part of the current selection, so you can hide them or

override their colors.

You can use several methods to interactively select items into the current selection.
You can use the drop-down list in the Selection Tree, select items directly in the Scene
View with the Select and Select Box tools, and you can select other items with similar
properties to an existing selection using the selection commands under the Home Tab
on the Select and Search Panel. Note: Right-clicking any item in the Selection Tree or
Scene View opens a context menu.

You can also customize the level at which you select items (selection resolution),
and modify the highlighting method for the items selected in the Scene View.

Selection Tree ® X

Standard v

B([5) Fully Appended Model NWD.nwd
O 02_Revit_Full-Structure- Foundations Only.nw«
22 Floors
22 Floor
2% 6" Concrete

@& Floor

82, Structural Columns

839 Concrete-Rectangular-Column
©2%2 PED 18" x 18"

)
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# @ Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
¢ Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column
# & Concrete-Rectangular-Column

%3 Structural Foundations

B[5) Drawing1.dwf

@& Beams (22)

@& Columns (15)

&9 HELP LINES (13)

@& Plates (87)

Figure 5-1: Selection Tree — Column Selected
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% {@J (_% (_(:[% E @ Find Items

] Quick Find Q
Select Save Select  Select |Selection
Selection | All Same | Tree [Dlsets v &

Select & Search ~

Figure 5-2: Home Tab - Select & Search Tools

5.2 Overriding color, transparency, and a transform

5.2.1 Manipulate Object Attributes

In Autodesk Navisworks, you can manipulate objects’ transforms (translation, rotation,
and scale), and also change appearance (color and transparency) of objects. All object
manipulation is carried out in the Scene View.

Any changes that you make to object attributes are considered to be global, (as if
they’d been changed in the original CAD model), and can be saved with Autodesk
Navisworks files. You have an option of resetting object attributes back to the state
they were in when imported from the original CAD files.

To transform objects, you can use three visual manipulation tools, or gizmos, available from the
Item Tools Tab, Transform Panel. You can also transform objects numerically.

+ | (=]
"3" O ] ﬁ Jrransparency 0 % Ewn

Move Rotate Scale Reset OCoIor: Dv Reset
Transform Appearance

Transform Appearance

Figure 9-3: Item Tools — Transform and Appearance Panels

To get a clearer view of objects as you manipulate them, you can use the Options
Editor to adjust the way in which the current selection is highlighted. For more
information, see Set Highlighting Method.

5.2.2 Using Measure Tools to Transform Objects
You can use the Measure Tools functionality to move and rotate the currently selected objects.
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5.2.3 Examples of Overrides

Figure 5-4: Color Change Override

Figure 5-4: Rotate Change Override

5.3 Hiding and turning on objects

Autodesk Navisworks provides tools that can be used to hide and display objects or
groups of objects. Hidden objects are not drawn in the Scene View.

5.3.1 Hide Selected Objects

You can hide the objects in the current selection so that they are not drawn in the
Scene View. This is useful when you want to remove specific parts of the model. For
example, when you walk down the corridor of building, you may want to hide a wall
that occludes your view of the next room.
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5.3.2 Hide Unselected Objects
You can hide all items except those currently selected so that they are not drawn in
the Scene View. This is useful when you only want to see specific parts of the model.

5.3.3

1.
2.

To hide selected objects

In the Scene View, select all items you want to hide.
Click Home tab  Visibility panel

l/_j" o »
Hide ==V .The selected objects are
now invisible.
A

Clicking Hide _® again displays the invisible objects.

5.4 Moving items

5.4.1

1.
2.
3.

5.4.2

wmn

To move an object numerically
Select the object you want to move in the Scene View.
Click the Item Tools tab, and slide out the Transform panel.
Type in numerical values into the manual entry boxes to move the object by the
amount entered:
e Position X, Y, Z represent translation distance in the current model unit.
e Transform Center X, Y, Z represent the translation center point.

To move an object with a measure tool
Select the object you want to move.

Click Review tab > Measure panel > Measure drop-down > Point Line ===,

Click the selected object to create the first point. This is the start point from
which the repositioning will be calculated.

Click the second point in the scene. This is the point where the object will be
moved to. There is now a line connecting the start point and the end point in
the Scene View.

If you want to be able to move the object several times, create more points in
the scene. Note: You can only select a point on another object in the scene.
Selecting a point in 'space’ is not a valid option. To reposition an object into
'space’, you can either use a translation gizmo or, if you know the distance by
which the object is to be moved, by overriding its transform.

Slide out the Measure panel, and click Transform Selected ltems 2 to move
the object to the second point. If you have multiple points in the scene, each
time you

click Transform Objects the selected object is moved to the next point.

5.5 Rotating items

5.5.1

1.

2.
3.

To rotate an object with gizmo
Select the object you want to rotate in the Scene View.

Click Item Tools tab > Transform panel > Rotate O
Use the gizmo to rotate the currently selected object:
e Before you can rotate the currently selected objects, you need to
position the origin (center point) of the rotation. To do this, place the
mouse over the arrow at the end of the desired axis. When the cursor

changes to @, drag the arrowon
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5.5.2

5.5.3

wmn

the screen to increase/decrease the translation along that axis. This
will move the gizmo itself.

Dragging the ball in the middle of the rotate gizmo enables you

to move it around, and snap it to points on other geometry

objects.

e Once the rotate gizmo is positioned correctly, place the mouse over one
of the curves in the middle, and drag it on the screen to rotate the
selected objects. The curves are color-coded, and match the color of the
axis used to rotate the object around. So, for example, dragging the blue
curve between the X and Y axes, rotates the objects around the blue Z
axis.

e To rotate the orientation of the gizmo to an arbitrary position, hold
down the CTRL key while dragging one of the three curves in the
middle.

e To snap the gizmo to other objects, hold the CTRL key while dragging
the ballin the middle of the gizmo.

To rotate an object numerically
Select the object you want to rotate in the Scene View.
Click the Item Tools tab, and slide out the Transform panel.
Type in numerical values into the manual entry boxes to move the object by the
amount entered:
e Rotation X, Y, Z represent degrees of rotation in the current model unit.
e Transform Center X, Y, Z represent the rotation center point.

To rotate an object with a measure tool
Select the object you want to move.

Click Review tab > Measure panel > Measure drop-down > Measure Angle ===,
To rotate the object, click three points on the selected object to determine how
the object is to be rotated.

Slide out the Measure panel, and click Transform Selected ltems 2. This
rotatesthe selected object from position A into position B (as shown in the
previous diagram). Clicking this button again, rotates the object from
position B into position C.

5.6 Scaling items

5.6.1

1.

2.
3.

5.6.2

1.

To resize an object with gizmo
Select the object you want to resize in the Scene View.

Click ltem Tools tab » Transform panel » Scale (ﬂ
Use the scale gizmo to resize the currently selected object:

e To resize the objects across a single axis only, use colored arrows at
the end of the axes. To resize the objects across two axes at the same
time, use colored triangles in the middle of the axes. Finally, to resize
the objects across all three axes at the same time, use the ball in the
center of the gizmo.

¢ You can modify the center of scaling. To do this, place the mouse over
the ball in the middle of the gizmo, and hold down the CTRL key while
dragging the ball on the screen.

To resize an object numerically
Select the object you want to resize in the Scene View. Page 32



2.
3.

Click the Item Tools tab, and slide out the Transform panel.
Type in numerical values into the manual entry boxes to move the object by the
amount entered:
e Scale X, Y, Z represent a scaling factor (1 being the current size,
0.5 half, 2 being double, and so on).
e Transform Center X, Y, Z represent the scaling center point.

5.7 Adding links

You can add links that point to various data sources, such as spreadsheets,
webpages, scripts, graphics, audio and video files and so on. An object can have
multiple links attached to it, although, only one link, called default, is shown in the
Scene View. The default link is the link that you add first, but you can mark a different
link as default, if necessary.

5.7.1

1.

2.
3.
4

4.

To add a link to an object
In the Scene View, select the desired geometry item.

Click Item Tools tab »Links panel *Add Link £
In the Add Link dialog box, enter the name for the link in the Name box.
In the Link to File or URL box, type in the full path to the required data source or

the URL address. You can also browse u to the folder containing the desired
externalfile.

Choose the category for your link from the Category drop-down list. by default,
your link has hyperlink category.

Tip: To create a custom category type, type its name directly into the

Category box. when you save your link, the corresponding user-defined
category is automatically created.

Optional: By default, your link is attached to the default center of the item’s
bounding box. If you want to attach your link to a specific point on the selected
item, click the Add button. A cross-hair cursor appears in the Scene View,
allowing you to select a point on the item where the link will be attached to.
Note: If you made a mistake, clicking the Clear All button deletes all attachment
points associated with this link and reverts to the link being attached to the
center of the item's bounding box.

Click OK.

To add several links to the same object

In the Scene View, select the desired geometry item.

Right-click and click Links Add Link.

Use the Add Link dialog box to add the first link. This is the default link, and it's
the only link that will be visible in the Scene View. You can choose a different
default link later, if necessary.

Right-click the object again, and repeat the previous steps to add all required links.

5.8 Viewing properties and adding fields

5.8.1

1.
2.

To examine object properties
Select the object of interest in the Selection Tree, or in the Scene View.

Open the Properties window under the Home Tab, and use the tabs to
navigate between the available property categories.
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5.8.2

Note: If more than one object is selected, the Properties window only shows the
number of selected items, and doesn’t show any property information.

To add a custom property tab

. Open the Properties window.

Select the object of interest in the Scene View or on the Selection Tree.
Right-click the Properties window, and click Add New User Data Tab. The new
property category is added for the currently selected object. By default, the tab
is called User Data.

5.9 Switching back to Revit

1.

2.

For Revit or products based on it, open the product in the usual manner, and
initialize the Navisworks SwitchBack add-in:

a. Open any existing project, or create a new one.

b. Click Add-Ins tab > External Tools » Navisworks SwitchBack to

enable it. You can now close the project, but don't close Revit.

Return to Autodesk Navisworks and open the desired file. As long as you are
working with an NWC file exported from Revit, or a saved NWF or NWD file, you
can SwitchBack to Revit.
Select an object in the Scene View, and click ltem Tools tab »SwitchBack

panel SwitchBack G Revit will load the relevant project, find and select the
item, and zoom to it. If SwitchBack was unsuccessful with the selected object,
and you receive an error message, try selecting further up the Selection Tree in
Autodesk Navisworks.

Tip: Alternatively, in the Clash Detective window, on the Results tab, you

can click the SwitchBack button. The Clash Detective feature is available

for Autodesk Navisworks Manage users only.

Note: If you try to use SwitchBack and the RVT file is not in the same location as
when it was saved, a dialog box will appear asking you to browse to the RVT file.
When using SwitchBack for the first time to load a Revit file, a 3D view based on the
chosen projection view mode is created in Autodesk Navisworks. The next time
SwitchBack is used to load a Revit file, the same projection view mode loads, unless
the projection view mode is changed

in Autodesk Navisworks.

5.10 Holding objects

1.
2.

Select the objects you want to hold either in the Scene View or in the Selection Tree.

Click Item Tools tab »Hold panel »Hold Ew

The selected objects are now held and will move with you through the model
when you use navigation tools, such as Walk, Pan and so on.

To release the held objects, click Hold Cw on the ribbon again.
If you want to reset the objects to their original position, click ltem >

Tools tab Transform panel Reset Transform
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6 Sorting and grouping

In this chapter:

The Selection Tree
Finding items

Saving selections as a set
Using the Quick Find tool

Using the Selection Inspector
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6.1 The Selection Tree

The Selection Tree Eis a dockable window, which displays a variety of hierarchical
views of the structure of the model, as defined by the CAD application in which the
model was created.

Autodesk Navisworks uses this hierarchical structure to identify object-specific paths
(from the file name down to a particular object).

For Revit 2014 and later (RVT or NWC) files, the model hierarchy can be structured
to display category, family, type and instance below each level, and show the
material from which the Revit object is made. For example, a door may be broken up
into constituent parts such as glass or wood panel.

By default, there are four options on the drop-down list:

e Standard. Displays the default tree hierarchy, including all instancing. The
hierarchy can be sorted alphabetically.

e Compact. Displays a simplified version of the hierarchy on the Standard option,
omitting various items. You can customize the level of complexity of this tree in
the Options Editor.

e Properties. Displays the hierarchy based on the items' properties. This
enables simple manual searching of the model by item property.

e Sets. Displays a list of selection and search sets. If no selection and search
sets have been created, this option is not shown.

Note: The list of the items on the Sets option is exactly the same as the list on
the Sets dockable window.

Additional customized Selection Tree options can be added by using the Autodesk
Navisworks API.

Naming of items reflects the names from the original CAD application, wherever
possible. You can copy and paste names from the Selection Tree. To do this, right-
click an item in the Selection Tree, and click Copy Name on the context menu.
Alternatively, you can click an item in the Selection Tree, and press CTRL + C. The
name is now copied to the clipboard.

There are different tree icons representing the types of geometry making up the
structure of the model. Each of these item types can be marked as hidden (gray),
unhidden (dark blue) or required (red).

Note: If a group is marked as hidden or required, then all instances of that group are
marked as hidden or required. If you want to operate on a single occurrence of an item,
then you should mark the instanced group (the level above, or the “parent”, in the
hierarchy) hidden or required.

6.2 Finding items

1. On the Selection Tree, click the items where you want to start searching from.
For example, if you want to search the whole model, select the Standard
option from the drop-down list, press and hold CTRL, and click all files that
comprise the model. If you want to limit your search to a selection set, select
the Sets option from the drop-down list, and click the required set.

2. Define a search statement:
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a. Click the Category column, and select the property category name from
the drop- down list, for example, ‘ltem’.
b. Inthe Property column, select the property name from the drop-
down list, for example, ‘Material’.
¢. Inthe Condition column, select the condition operator, for example, “Contains”.
d. Inthe Value column, type in the property value to search for, for
example, “Chrome”.
e. If you want to make your search statement case-insensitive, right-
click it, and click Ignore String Value Case.
3. Define more search statements, if required.
By default, all statements are ANDed. This means that they all need to be
true for an item to be selected. You can make a statement use OR logic, by
right-clicking it and clicking Or Condition. If you are using two statements,
and marked the second one as ORed, this means that an item will be
selected if either of these statements is true.
4. Click the Find All button. The search results are highlighted in the Scene View
and the Selection Tree.

6.3Saving selections as a set

The Sets window &%= ~is a dockable window, which displays both selection sets

and search sets available in your Autodesk Navisworks file.

The selection sets are identified by this icon: ®, and the search sets are identified
by this icon: ™.

Note: The list of the items on the Sets window is exactly the same as the list on the
Sets drop- down option on the Selection Tree.

You can customize the names of selection and search sets, and add comments. You
can copy and paste names from the Sets window. To do this, right-click an item in the
Sets window, and click Copy Name on the context menu. Alternatively, you can click an
item in the Sets window, and press CTRL + C. The name is now copied to the clipboard.

You can also show the selection and search sets as links in the Scene View. These
links are created automatically by Autodesk Navisworks. Clicking on a link restores
the geometry within the corresponding selection or search set to the active selection,
and highlights it in the Scene View and on the Selection Tree.

You can use the buttons in the Sets window to create and manage selection and
search sets in the Autodesk Navisworks file.

6.4Using the Quick Find tool

1. Click Home tab »Select & Search panel.

2. In the Quick Find text box “““ X tyoe in the string to search for in
all item’s properties. This can be a word or a few words. The search is not
case-sensitive.

3. Click Quick FindX'. Autodesk Navisworks finds and selects the first item in the
Selection Tree that matches the entered text, selects it in the Scene View, and
stops the search.
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4. To find more items, click Quick Find<{ again. If there are any more items that
match the entered text, Autodesk Navisworks selects the next one in the
Selection Tree, selects it in the Scene View, and stops the search. Subsequent
clicks find next instances.

Command entry: To open the Quick Find dialog box: CTRL + F. To Find Next: F3
6.5Using the Selection Inspector

The Selection Inspector (%is a dockable window which can be accessed in the
Home Tab, which displays a list of all the selected objects and the Quick Properties
associated with those objects.

You can inspect a selection from the Selection Tree or Scene View. Alternatively,
choose a Selection Set or a Search Set. You can then zoom the selection to display it
within the model, or modify it by deselecting objects and adding property definitions.

When you save a selection, it appears in the Sets window. You can then rename your
selection set. See Sets Window for more details.

All the objects that are visible within the Selection Inspector window may be
exported into a CSV file. You must deselect objects if you wish to exclude them
from the exported file.
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7 Clash Detection

In this chapter:
Creating a clash test and setting rules

Selecting objects to clash and adding clearances
Running the clash

Resolving and reducing clashes

Grouping and assigning clashes

Creating report; Viewpoints

Creating reports: HTML
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7.1 Creating a clash test and setting rules

Exported clash tests can be used as a basis to define custom clash tests. If you have a common
set of clash tests that you reuse on multiple projects, you can turn them into a custom

clash test. Once installed as a custom clash test, all the tests can be selected and run

directly from the Select Tab. The results from all tests are combined and presented as

the results of the custom clash test. The name of each individual test in the custom

clash test is displayed in the Description field of the results.

Custom clash tests are an excellent way to roll out a standardized set of tests
across an organization. They allow the expertise of “power” users to be reused by
everyone. They can also be seen as a way of implementing object intelligence. For
example, a custom clash test could be written that checked for compliance with a
local building code based on object information and properties defined in a
particular CAD system.

7.1.1 To define and use a custom clash test

1. Export Clash Tests to an XML file. The name of the file is used as the default
name for the custom test.

2. If you want, change the name of the custom test by editing the XML file directly.
The top- level element in the XML file is called “batchtest”. The name of the
custom test as displayed to the user is defined by the “name” attribute. The
name of the custom test as saved in a file is defined by the “internal name”
attribute.

3. Toinstall the custom test, copy the exported XML file to the custom_clash_tests
folder of one of the Autodesk Navisworks search directories, for example:
C:\Documents and Settings\All Users\Application Data\Autodesk Navisworks
2018\custom_clash_tests. See Search Directories for more information.

4. Restart Autodesk Navisworks. On startup, Clash Detective checks

these search directories for custom clash tests.

To use the custom test, open the Clash Detective window, and click the Select tab.
Select your custom test from the Type drop-down box.

7. Click the Start button. All other options and rules are specified by the custom test.

oo

7.2 Selecting objects to clash and adding clearances

1. If the Clash Detective window is not already open, click Home tab Tools

panel Clash Detective © 2.

Click the Tests panel expand button, and select the test you want to configure.
Click the Select tab.

There are two identical panes in this tab called Selection A and Selection B.
These panes contain tree views of two sets of items that will be tested against
each other during the clash test, and you need to select items in each. You can
select the items by choosing an option from the drop-down list for each
selection tree and manually selecting items from the tree hierarchies. Any
selection sets in the scene are also available from the drop-down list, which is a
quick and useful method of setting up items across sessions (see Interactive
Geometry Selection).

You can also transfer the current selection to one of the selection panes by
selecting items in the usual way in the Scene View or Selection Tree and
clicking the appropriate Use Current Selection button.

w N
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4. Optional: Select the appropriate Self Intersect button to test the

corresponding set for self-intersection, as well as intersection against the
other set.

Optional: You can include the clashing of points, lines, or surfaces in your test.
Underneath each window there are three buttons that correspond to surfaces,
lines and points. To toggle a button, click it.

So, for example, if you want to run a clash test between some surface
geometry and a point cloud, you can set up the geometry in the Selection A
pane, and click the Point Cloud button under the Selection B pane. The
Surface button under the Selection A pane is toggled on by default.
Additionally, you could set the clash Type to Clearance with a Tolerance of 1
meter.

Note: If the Type is set to Hard, lines and surfaces will actually need to intersect
with any points to register a clash.

Clash Detective ¢ X
Test 1 Last Run: Thursday, June 1, 2017 11:36:05 AM
Clashes - Total: 0 (Open: 0 Closed: 0)
Name Status Clashes [ New Active I Reviewed | Approved  Resolved
Test 1 Done 0 0 0 0 0 0
| B~
| & AddTest || Resetan | CompactAll | Deleteall | 3
Rules | Select |Results l Report
Selection A Selection B
Standard v Standard v
[ ©[5)02_Revit_Full-Structure.nwe [ ©[5)02_Revit_Full-Structure.nwe
@2 Floors @2 Floors
@2 Structural Columns @2 Structural Columns
@2 Concrete-Rectangular-Column @2 Structural Foundations
LI33W Shapes-Column] P Rodotruct 9
@2 Structural Foundations
@2 Structural Framing
WV CINEIE B 5 (D% |8 s
Settings
Type: | Clearance v | Tolerance: |0ft Oin
Link: | None v | step(seq: 0.1 Run Test
] Composite Object Clashing

Figure 11-1: Clash Detective

7.3 Running the clash

If the Clash Detective window is not already open, click Home tab

7~

&)

panel Clash Detectives™ 2.

wn -~

Click the Tests panel expand button and select the test you want to run.
Click the Select tab and set the required test options.

Once the Selection A and Selection B items are selected, and the clash
type and tolerance defined, click the Run Test button to start the test
running.

‘Fools
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Note: The progress bar shows how far through the test Clash Detective has got. If

you wish to stop the test at any time, press the Cancel button. All clashes found up

until the interrupt will be reported, and the test will be saved with a Partial status.

When the test is complete

the Results tab will open displaying the results of the test, unless there were no clashes found.

7.4 Resolving and reducing clashes

There are four default clash test types for you to choose from:

e Hard. Choose this option if you want the clash test to detect actual
intersections between geometry.

¢ Hard (Conservative). This option performs the same clash test as Hard,
however, it additionally applies a conservative intersection method.

e Clearance. Choose this option if you want the clash test to check for geometry
within a specific distance from other geometry (see tolerance for more
information). You can use this type of clash when, for example, pipes need to
have space for insulation around them.

Note: Clearance clashes are not the same as “soft” clashes. Clearance
clashes detect for static geometry coming within a distance of other geometry,
whereas soft clashes detect potential clashes between moving components.
Clash Detective supports soft clash checking when you link it to Object
Animation.

¢ Duplicates. Choose this option if you want the clash test to detect for
duplicate geometry. You can use this type of clash test to check a model
against itself to ensure the same part has not been drawn, or referenced
twice, for example.

7.5 Grouping and assigning clashes

7.5.1 To group clashes
1. On the Results tab, select all clashes you want to group together and click Group.
2. Type in a new name for the group, and press Enter.
Note: Clash groups are identified with the icon. When clashes are grouped,
they are treated as a single clash in the count at the top of the Clash Detective
window. Each clash group is counted as a single clash unless no clashes
have been added to it, in which case it will not be included in the count.

When you click the created clash group, the two panes in the Items panel show all the
clashing items contained within that clash group, and all corresponding clashes are
shown in the Scene View.

7.5.2 To create a clash group

#
1. Click New Group [ on the Results tab. A new group called New Group X
is added above the currently selected clash (or at the top of the list if
nothing is selected).
2. Type in a new name for the group, and
press Enter. Note: Clash groups are
identified with the & icon.
3. Select clashes you want to add to this group, and drag them into the group.
Note: When clashes are grouped, they are treated as a single clash in the count
at the top of the Clash Detective window. Each clash group is counted as a
single clash unless no clashes have been added to it, in which case it will not be
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4. When you click the created clash group, the two panes in the ltems panel

show all the clashing items contained within that clash group, and all
corresponding clashes are shown in the Scene View.

|
<
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Figure 11-2: Results and Clash Groups

7.6 Creating report; Viewpoints

11.6.1 To save viewpoints with clash results manually
1. Inthe Clash Detective window, click the Results tab.

2. Right-click in the Viewpoints column for a clash result and select Save Viewpoint.
The position displayed in the Scene View will be saved as the viewpoint for the
clash. If there is no existing viewpoint thumbnail then a new viewpoint thumbnail

will be created in the Results grid.
Note: Selecting Focus on Clash always returns to the clashes original default viewpoint.

7.6.2 To save viewpoints with clash results automatically
1. Inthe Clash Detective window, click the Results tab Display Settings show/hide button.
2. Select the Auto-Update option from the Viewpoint drop-down list.

Now when you navigate away from the default viewpoint for a clash in the
Scene View, the viewpoint for the clash will be updated to the new position. If
there is no existing viewpoint thumbnail then a new viewpoint thumbnail will be
created in the Results grid. Note: Selecting Focus on Clash always returns to
the clashes original default viewpoint. Once redlining has been added,

subsequent changes to the viewpoint due to navigation
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will not be saved. In order to save a different viewpoint, the redlining
must first be removed using the redline Erase tool, or by manually saving
the viewpoint.

m X

Test 1 Last Run: Thursday, June 1, 2017 11:44:54 AM
Clashes - Total: 14 (Open: 14 Closed: 0)

Name Status Clashes || New JAcive  JReviewed ] Approved  Resolved

Test 1 Done 14 14 0 o o 0
| GRAddTest | | ResetAll | CompactAll | DeleteAll | B~

Rules l Select | Results | Report

[  New Group ) w &, Assign @ SHNone v | |5 |k | &3 Re-runTest

Name Q)63 Status Level Grid In... Found Highlighting >
4 (%) New Group New [JL02TOP.. B4 1 01-06- E
®Closh! (@) New v L02TOP... B-4  11:44:54 01-06-2 Useitemcolors | | |2
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Figure 7-3: Clash Detective Results — Viewpoints

Figure 7-4: Clash Viewpoint Example
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7.7 Creating reports: HTML

1.

2.
3.

6.
7.

In the Clash Detective window, run the desired test. If you ran all tests in the Tests
panel, select the test you want to view the results for.
Click the Report tab.
In the Contents area select the check boxes for the data you want to appear in
the report for each clash result. This can include Quick Properties relating to the
items involved in the clash, how to find them in the standard Selection Tree from
root to geometry, whether images or simulation information should be included,
and so on.
In the For-Clash Groups Include drop-down list, select how to display the clash
groups in your report.
Note: If your test does not contain any clash groups, this box is not available.
Choose from the following options:
e Group Headers Only - your report will include summaries of clash
groups and individual clashes not in groups.
¢ Individual Clashes Only - your report will only contain individual clash
results, and will not distinguish those results that have been grouped.
For each clash that belongs to a group, an extra field, called Clash
Group, can be added to the report to identify it. To enable this
functionality, select the Clash Group check box in the Contents area.
e Everything - your report will contain summaries of clash groups that you
have created, clash results that are part of each group, and individual
clash results. For each clash that belongs to a group, an extra field,
called Clash Group, can be added to the report to identify it. To enable
this functionality, select the Clash Group check box in the Contents area.
Use the Include Clash Types box to select the clash results that you want to report on.
Select the type of report in the Report Type box:
e Current Test creates a single report file for the current test.
e All Tests (Combined) creates a single file containing all results from all tests.
e All Tests (Separate) creates a separate file for each test containing all results.

8. Select the format of the report in the Report Format box:

e XML creates an XML file containing all the clashes and a jpeg of their
viewpoints alongside their details. On choosing this option, you will need
to select or create a folder for the files and enter a name for the XML
file.

e HTML will create an HTML file containing all the clashes and a jpeg of
their viewpoints alongside their details. On choosing this option, you will
need to select or create a folder for the files and enter a name for the
HTML file.

e HTML (Tabular) will create an HTML tabular file containing all the
clashes and a jpeg of their viewpoints alongside their details. On
choosing this option, you will need to select or create a folder for the files
and enter a name for the HTML file. HTML tabular files can be opened
and edited in Microsoft Excel 2007 onwards. Note: To customize the
appearance or layout of the HTML / HTML (Tabular) file, you will need to
edit the clash_report_html.xsl / clash_report_html_tabular.xsl file. The
installed file is located in the stylesheets subdirectory of the Autodesk
Navisworks install directory. You can copy the edited file to the
stylesheets subdirectory of any of the Autodesk Navisworks search
directories. See Search Directories for more information.
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e Text creates a TXT file containing all the clash details and the location
of a jpeg of each clash. On choosing this option, you will need to select
or create a folder for the files and enter a name for the TXT file.

e As Viewpoints creates a folder in the Saved Viewpoints dock able
window (this window is automatically displayed when the report is
run), with the same name as the test. Each clash is saved as a
viewpoint in this folder, with a comment attached containing the clash
result details.

Note: The Home view is the default camera orientation for clash viewpoints.

9. Click the Write Report button to write the report.
Note: Reports will respect any sorting of the data that you have done, for
example into ascending or descending order, on the Results tab.

Clash Detective ¥ X

Test 1 Last Run: Thursday, June 1, 2017 11:44:54 AM
Clashes - Total: 14 (Open: 14 Closed: 0)

Name Status Clashes || New Adive || Reviewed || Approved  Resolved
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\G‘Add Test | | ResetAll l Compact All | Delete All_| B~
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Contents Include Clashes
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(V] Clash Point Group Headers Only
[] Date Found [T] Include only filtered results
]Assigned To Include these statuses:
[¥] Date Approved —
i/: PeRcwaCY. [V Active
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] tay [ Reviewed
Item Path =
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/) Item ID =
= [V Resolved
(/] Status
(V] Distance
[] Description
(V] Comments
[¥] Quick Properties
[]Image
[/] Simulation Dates
[] Simulation Event
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Figure 11-5: Clash Detective Report
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8 The TimeLiner

In this chapter:

Configuring appearances

Creating tasks

Adding selection sets to a task

Adding multiple tasks and running the movie
Simulating settings

Exporting the TimeLiner

Adding a data source
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8.1 Configuring appearances

The TimeLiner tool adds schedule simulation to Autodesk Navisworks. TimeLiner imports
schedules from a variety of sources. You can then connect tasks in the schedule with
objects in the model to create a simulation. This allows you to see the effects of the
schedule on the model, and compare planned dates against actual dates. Costs can
also be assigned to tasks to track the cost of a project throughout its schedule.
TimeLiner also allows the export of images and animations based on the results of the
simulation. TimeLiner will automatically update the simulation if the model or schedule
changes.

You can combine the functionality of TimeLiner with other Autodesk Navisworks tools:

Linking TimeLiner and Object Animation together enables the triggering and
scheduling of object movement based on start time and duration of project
tasks, and can help you with workspace and process planning. For example, a

TimeLiner sequence may indicate that when a particular site crane moves from

its start point to its end point over the course of a particular afternoon, a
workgroup working nearby causes an obstruction along its route. This potential

obstruction problem can be resolved before going to site (e.g., the crane can be

moved along a different route, the workgroup moved out of the way, or the

project schedule altered). See Add Animation to TimeLiner Schedules for more

information.

Linking TimeLiner and Clash Detective together enables the time-based clash
checks on the project. See Clash Detective User Guide for further details on
time-based clashing. Note: This feature is available for Autodesk Navisworks
Manage users only.

Linking TimeLiner, Object Animation, and Clash Detective together enables
clash testing of fully animated TimeLiner schedules. So, instead of visually
inspecting a TimeLiner sequence to make sure, for example, that the moving
crane didn't collide with a workgroup, you can run a clash test.

Note: This feature is available for Autodesk Navisworks Manage users only.

8.2Creating tasks

1.

Load your model into Autodesk Navisworks (see Open Files if you need help).

2. Click Hometab »>Tools panel >TimeLiner @ and click the

Tasks tab in the TimeLiner window.

=
Click Add Task * or right-click anywhere in the task view, and click Add

Task on the context menu. o
=i
Note: You can click on an existing task and select Insert Task L==] to insert a

task above the selected task.

Enter the name for your task, and press Enter. The task is now added to your
schedule. Note: If you press Enter when the bottom task in the task view is
selected, then a new task will be created below it.
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8.3Adding selection sets to a task

8.3.1 To add tasks based on the Selection Tree structure

1. If the TimeLiner window is not already open, click Home tab »Tools panel »>TimeLiner

=
2. In the TimeLiner window Tasks tab, click Auto-Add Tasks -+

3. Click For Every Topmost Layer if you want to create tasks with the same names
as each topmost layer in the Selection Tree.
Click For Every Topmost ltem if you want to create tasks with the same names
as each topmost item in the Selection Tree. This can be a layer, a group, block
or cell, or geometry, depending on how the model is constructed.

Note: Planned Start and End dates will be automatically created, starting from the
current system date and incrementing by one day for each subsequent end and start
date. The Task Type will be set to Construct.

TimeLi

Tasks | Data Sources ] Configure | Simulate

IL_!,._AudTasklgé[@-lq”%pxnacn-l@%lﬁ|& |Be|= |2 ||| .Fﬂ Zoom:

Active MName Status | Planned Start | Planned End | Actual Start | ActualEnd | Task Type | Attached = Total Cost
B & | e | = @i e leni el o [opiks.] |
Task 2 1 8f3j2017 6/4/2017 6/3/2017 6/4j2017 Demolish Explicit S.
™ Task 3 =1 elsf2017 61612017 6/5/2017 66/2017 Temporary  Explicit 5..

Figure 8-1: Adding Timeliner Tasks

8.3.2 To build tasks from a data source
1. If the TimeLiner window is not already open, click Home tab » »

Tools panel TimeLiner O

2. Inthe TimeLiner window, the Data Sources tab, click the Refresh button, select
either Selected Data Source or All Data Sources then select Rebuild Task
Hierarchy in the Refresh from Data Source Dialog Box and click OK.
This will import all of the tasks from the project file into TimeLiner.
Note: You can also right-click on a file in the Data Sources tab and select the
Rebuild Task Hierarchy option.

3. Click the Tasks tab to view the created tasks. The task table is populated in
accordance with predefined settings for the data source. You can make any
necessary overrides in the Field Selector Dialog Box.

Note: Although the tasks have now been imported into TimeLiner, you still need to
Attach Tasks to Geometry before you can run a simulation. The fastest way to attach
imported tasks is by applying rules (see Use Rules to Attach Tasks).
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8.4 Adding multiple tasks and running the movie

1. If the TimeLiner window is not already open, click Home tab »Tools panel »>TimeLiner

2. On the Tasks tab, click the task you want to add an animation to, and use the
horizontal scroll bar to locate the Animation column.

3. Click the drop-down arrow in the Animation field, and select a scene or an
animation set from a scene. When you select a scene, all animation sets
recorded for this scene will be used.

4. Click the drop-down arrow in the Animation Behavior field, and select how the
animation will play during this task:

e Scale - the duration of the animation is matched to the duration of the
task. This is the default setting.

e Match Start - the animation starts when the task starts. If the animation
runs past the end of the TimeLiner simulation, the end of the animation
will be clipped.

e Match End - the animation starts early enough so that it ends just when
the task end. If the animation starts before the beginning of the TimeLiner
simulation, the start of the animation will be clipped.

8.5Simulating settings
The Settings button on the Simulate tab provides access to the Simulation Settings dialog box.

It is possible to override the Start and End dates that the simulation runs between.
Selecting the Override Start/End Dates check box enables the date boxes and allows
you to choose the start and end dates. By doing this, you can simulate a small sub-
section of the overall project. The dates will be shown on the Simulate tab. These dates
will also be used when exporting animations.

|aimeLines
| Tasks | Data Sources | configure | simulate
L 0| 0D
[er172017 = 09:00
e 6172017
D " ! ! Thu Jun 01, 17 FriJun 02, 17 Sat Jun 03, 17 Sun Jun 04, 17 Mon Jun
@ P Pk A Tot
Name | Status | Planned Start | Planned End | Actual Start | ActualEnd | Total Cost = 1 = . = = = -
» N T T T W S T ! O e
Pending Taskz B 6/3/2017 64/2017 6/3j2017 6/4/2017 De e |
Pending Task3 B 6/5f2017 6/6j2017 6/512017 616/2017 Te

Figure 12-2: Simulate Tab
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Figure 8-3: Simulate Settings

You can define the Interval Size to use when stepping through the simulation using the
playback controls. The interval size can be set either as a percentage of the overall
simulation duration or to an absolute number of days or weeks, and so on.

Use the drop-down list to select the interval unit, then use the Up and Down arrow
buttons to increase or decrease the interval size.

It is also possible to highlight all the tasks that are being worked on during the interval.
By selecting the Show All Tasks in Interval check box, and, for example, setting the
Interval Size to 5 Days, all tasks being worked on during those 5 days will be set to
their Start Appearance in the Scene View, including those that begin and end within the
bounds of the interval. The Simulation slider will show this by drawing a blue line under
the slider. If this check box is clear, tasks that begin and end within the bounds of the
interval will not be highlighted in this manner, and will need to overlap with the current
date in order to be highlighted in the Scene View.

You can define the overall Playback Duration for the complete simulation (the time
needed to play it through from start to finish). Use the Up and Down arrow buttons to
increase or decrease the duration (in seconds). You may also enter a duration directly
into this field.

You can define whether the current simulation date should be overlaid in the Scene
View, and if so whether it should appear at the top or bottom of the screen. From the
drop-down, choose from None (to display no overlay text), Top (to display the text at
the top of the window), or Bottom (to display the text at the bottom of the window).

You can Edit the information displayed in the overlay text using the Overlay Text
Dialog Box. This dialog box also makes it possible to alter the Font Type, Style and
Size by clicking on the contained Font button.

You can add animation to an entire schedule, so that during the TimeLiner sequence
playback, Autodesk Navisworks will also play the specified viewpoint animation or
camera.

The following options can be selected in the Animation field:
¢ No Link - no viewpoint animation or camera animation will be played.
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e Saved Viewpoints Animation - links your schedule to the currently selected
viewpoint or viewpoint animation.

e Scene X - Camera - links your schedule to a camera animation in the selected
animation scene.

You can pre-record suitable animations for use with the TimeLiner simulation (see
Record and Play Animations). Using animation also affects the Animation Export.

View area. Each view will playback the schedule depicting Planned and Actual relationships:

e Actual. Choose this view to simulate the Actual schedule only (that is,
only use the Actual Start and Actual End dates).

e Actual (Planned Differences). Choose this view to simulate the Actual
schedule against the Planned schedule. This view will only highlight the items
attached to the task over the Actual date range (that is, between Actual Start
and Actual End. See diagram below for graphical representation). For time
periods where the Actual dates are within the Planned dates (on schedule), the
items attached to the task will be displayed in the Task Type Start Appearance.
For time periods where the Actual dates are early, or late in comparison to the
Planned dates (there is a variance), then the items attached to the task will be
displayed in the Task TypeEarly or Late Appearance, respectively.

e Planned. Choose this view to simulate the Planned schedule only (that is,
only use the Planned Start and Planned End dates).

¢ Planned (Actual Differences). Choose this view to simulate the Actual
schedule against the Planned schedule. This view will only highlight the items
attached to the task over the Planned date range (that is, between PlannedStart
and Planned End. See diagram below for graphical representation). For time
periods where the Actual dates are within the Planned dates (on schedule), the
items attached to the task will be displayed in the Task TypeStart Appearance.
For time periods where the Actual dates are early, or late in comparison to the
Planned dates (there is a variance), then the items attached to the task will be
displayed in the Task TypeEarly or Late Appearance, respectively.

e Planned Against Actual. Choose this view to simulate the Actual schedule
against the Planned schedule. This will highlight the items attached to the task
over the entire Planned and Actual date range (that is, between the earliest of
Actual and Planned Start dates and the latest of Actual and Planned End dates.
See diagrams below for graphical representation). For time periods where the
Actual dates are within the Planned dates (on schedule), the items attached to
the task will be displayed in the Task Type Start Appearance. For time periods
where the Actual dates are early, or late in comparison to the Planned dates
(there is a variance), then the items attached to the task will be displayed in the
Task Type Early or Late Appearance, respectively.

8.6 Exporting the TimeLiner

Kl

1. Inthe TimeLiner window, Simulate tab, click Export
Animation .The Animation Export
dialog box opens.

2. To export the currently selected viewpoint animation, select Current
Animation in the Source box.

To export the currently selected object animation, select Current Animator
Scene in the Source box.

To export a TimeLiner sequence, select TimeLiner Simulation in the Source bOXPage 52



4.

5.

Set up the rest of the boxes in the Animation Export dialog box, and click OK.
For more information, see Animation Export Dialog Box.

In the Save As dialog box, enter a new filename and location, if you want to
change from those suggested.

Click Save.

8.7 Adding a data source

8.7.1 To import data from an external project schedule

1.

w N

If the TimeLiner window is not already open, click Home tab » »
Tools panel TimeLiner O

In the TimeLiner window click the Data Sources tab.

Click the Add button and choose the required option from a list of the project
sources that may be connected to on the current PC.

Note: For more information on which sources are typically available, see
Supported Scheduling Software.

Use the standard Open dialog box to browse to and open the desired

project file. TimeLiner accesses the selected file in accordance with the
predefined parameters configured for the corresponding data source using

a COM interface.

Depending on the data source, the Field Selector Dialog Box may be displayed.
You can use it to override some of the predefined data import options.

By default, your data source is called “New Data Source(x)”, where “X” is

the latest available number. To make your data source more descriptive,
right-click it,

click Rename on the context menu, and enter a new name.

8.7.2 To import data from a Primavera

Note: This procedure shows how to import data from a Primavera P6 project. Follow
the same steps to import data from a Primavera P6 V7, V8 or V8.2 project, selecting
the Primavera P6 V7, V8, or V8.2 options where applicable.

1.

n

If the TimeLiner window is not already open, click Home tab > »

Tools panel TimeLiner kL).

In the TimeLiner window, click the Data Sources tab.

Click the Add button and click Primavera P6 (Web Services).

Note: If you can'’t see this option, you must set up a Primavera Web Server first.
Refer to the Primavera P6 Web Server Administrator Guide (available in your
Primavera documentation).

When the Primavera login dialog box is displayed, enter your user name,
password, and the server address.

Tip: The Server Address is the name of a machine on your domain or an IP
address for the server.

In the Primavera P6 Database Instance Selection dialog box double-

click the desired Instance ID to select it.

In the Primavera P6 Project Selection dialog box double-click the desired
project file to open it.
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7. Use the Field Selector Dialog Box to override some of the predefined
data import options.
TimeLiner connects to the selected project file.

8.7.3 To import CSV data
1. If the TimeLiner window is not already open, click Home tab » »

Tools panel TimeLiner O

In the TimeLiner window click the Data Sources tab.

Click the Add button and click CSV Import.

Use the standard Open dialog box to locate the desired project file in CSV

format, and click Open.

5. Inthe Field Selector Dialog Box, use the CSV Import Settings area to specify
how your data should be imported into TimeLiner.
Note: The CSV import settings, including field mappings, are remembered by
the system and pre-populated when the dialog box opens. If you are linking to a
different CSV file than was previously used, TimeLiner will attempt to map any
columns to similarly-named columns in the CSV file.
You should have a column in the CSV file containing unique data, for example
an incrementing number, and map it to the Synchronization ID field. This unique
data must remain the same once it has been set against a row in the CSV file to
enable synchronization to enable you to rebuild and synchronize the data
source link. The Task Name field must also be mapped.

e Select the Row 1 Contains Headings check box if you want the first row
of data in your CSV file to be treated as column headings. TimeLiner will
use it to populate the External Field Name options in the grid.

If the first row of data in your CSV file does not contain column
headings, clear this check box.

e Select the Automatically Detect Date and Time option if you want
TimeLiner to attempt to determine the date/time format used in your
CSV ile.

First, TimeLiner applies a set of rules to try to establish the date/time
format used in the document; if it is not possible, it uses the local settings
on your system.
Select the Use Specific Date/Time Format option if you want to manually
specify the date/time format that should be used. When this radio button
is selected, you can enter the required format into the box provided. For
the list of valid codes, see Field Selector Dialog Box.
Note: If one or more date/time-based columns are found to contain
fields where the data cannot be mapped to a valid date/time value
using the manually- specified format, TimeLiner will 'fall back' and
attempt to use the automatic date/time format.
6. By default, your data source is called “New Data Source(x)”, where “x” is

the latest available number. To make your data source more descriptive,

right-click it,

click Rename on the context menu, and enter a new name.

Ao

Page 54



8.7.4 Timeliner Simulate Example

Figure 8-4: Timeliner Simulation Example
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9 Quantification

In this chapter:
Setting up your workbook
Dragging items to the workbook
Taking off the entire model

Exporting the takeoff
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9.1Setting up your workbook

Quantification supports integration of three-dimensional (3D) and two-dimensional
(2D) design data. You can combine multiple source files and generate quantity
takeoff. Takeoff an entire building information model (BIM) and create synchronized
project views that combine information from BIM tools such as Revit® and AutoCAD®
software together with geometry, images, and data from other tools. You can also
perform a virtual takeoff for items with no associated model geometry or properties.

Your takeoff data can then be exported to Excel for analysis and shared with other
project team members in the cloud using Autodesk BIM 360® for optimized
collaboration.

Quantification can count and measure item quantities associated with these disciplines:

¢ Civil (earth, road, drainage)
e Architecture (doors, walls, windows)
e Engineering (structural, mechanical, electrical,

plumbing) The available measurements (variables) are:

Length
Width
Thickness
Height
Perimeter
Area
Volume
Weight
Count

9.1.1 Quantification workflow

A typical workflow begins with a design file created in Autodesk design applications,
such as AutoCAD, AutoCAD Architecture, AutoCAD Civil 3D, and Revit. Before
publishing a design file, an architect, engineer, or other designer, determines which
features (model, layouts, layers, properties and so on) to include in the file. After
determining the content, a designer publishes the drawing and shares the file with the
Estimator. In some cases, designers scan or save drawings as image files and send
them for estimation. When the files are received, the Quantification workflow begins.

In Navisworks, open a design data source file

Open the Quantification workbook

Set up a project

Create or select takeoff items

Hide unwanted items

Use measurement tools for items not in catalog (for virtual takeoff)
Organize takeoff items (change item order, create new items)
Edit formulas/parameters

Refresh model after changing data

10 Analyze and validate takeoff data

11. Output takeoff data to Excel XLSX format

CONOO A WN =
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9.2Dragging items to the workbook

1. Open the Quantification HHwindow in the Home Tab.

2. Click and drag to the title bar at the top or side of the window.

3. Optional: to prevent a window from automatically docking while you drag it,
hold down the CTRL key.

Note: The docking tool allows you to place windows in a specific relationship to
the canvas areas.

9.3Taking off the entire model

Virtual takeoff can be carried out when you want to add takeoff objects that are not
linked to a model object or item, for example:

e where an object has geometry, but has no properties
e where an object does not have geometry, and has no properties

This could be the case if you did not save the properties from the original design
application with your file, or that the object you want to takeoff does not exist in the
model. In both cases, you can associate a viewpoint with the virtual takeoff object so
you can navigate your way back to it during the takeoff process. Once your virtual object
is taken off, you can begin to add properties by using formulas, which provides
quantities for the object.

Note: You cannot refresh a virtual takeoff, since it is not linked to the model.

Quantification Workbook

ﬁj—' (/09] ] g' | | [%Model Takeoff'] (%Vlrmal Takeoff v CJ Hide Takeoff '\:\J Show Takeoff I l@v ]

- - -

Items WBS
[Ch Columns
[Ch Plates
[ PED 18" x 18%(1)
[} 6" Concrete(1)

oW NN -

Figure 13-1: Quantification Take-off Tools

9.3.1 Takeoff objects with no properties

If you want to takeoff objects that have geometry in the model, but no associated
properties, you can use a virtual takeoff. This may be the case if you did not save the
object properties from the original design application, such as AutoCAD or Revit. In this
instance, you can use measurement tools and formulas to add some property details to
the Quantification workbook.

You can also associate a viewpoint with the takeoff object, to help reference its
position in the model.

9.3.2 Takeoff unmodeled objects

You can capture the quantities of objects that do not appear in the model using a virtual
takeoff. Virtual takeoff takes advantage of viewpoints, formulas, measurements, and
manual overrides.
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You can add a virtual takeoff to an existing Item, then associate a Viewpoint for that ltem,
which you can update and refer back to, make measurements and create redlines. The

camera icon in the Viewpoint field denotes the associated Viewpoint. Click it to view the
ltem in the Scene.

9.3.3 Perform 2D takeoff

2D Takeoff allows you to measure lines, areas and counts on a 2D sheet. Rather than

carrying out manual calculations on paper sheets, you can markup geometry and
perform accurate calculations. The geometry is then taken off automatically, to sit
alongside the 3D takeoffs in your Quantification workbook.

2D Takeoff supports native and scanned DWF files and non-native DWFs files such
as PDF. See Supported file types.

2D Takeoff Workflow:

Select or create an ltem in the ltems Catalog.

Open the 2D sheet you want to use. If your project contains several sheets or
models, use the Sheet Browser to select a 2D sheet.

Select a Markup tool from the 2D Takeoff toolbar.

Draw your markup on the sheet.

Your Takeoff results appear in the Quantification workbook.

9.4 Exporting the takeoff

To export Quantification data

1.

no

In the Quantification Workbook, click Import/Export Catalogs

L&~
and Export Quantities |£
From the drop-down list, click Export Quantities to Excel

Save the file to your preferred location
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10 Presenting, Animating, and Exporting

In this chapter:

Animating saved viewpoints
Animating objects

Creating a script
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10.1 Animating saved viewpoints

There are two ways to create viewpoint animations in Autodesk Navisworks. You can
either simply record your real-time walk through, or you can assemble specific
viewpoints for Autodesk Navisworks to interpolate into a viewpoint animation later.

Viewpoint animation is controlled through the Animation tab and the Saved Viewpoints window.

It is worth remembering that you can hide items in viewpoints, override colors and
transparencies and set multiple section planes and these will all be respected by a
viewpoint animation. This way you can easily create powerful viewpoint animations.

Once a viewpoint animation is recorded, you can edit it to set the duration,
the type of smoothing and whether it loops or not.

There is also nothing to stop you from copying viewpoint animations (hold down the
CTRL key when dragging an animation on the Saved Viewpoints window), dragging
frames off the animation into a blank space on the Saved Viewpoints window to
remove them from the viewpoint animation, editing individual frames attributes,
inserting cuts or dragging other viewpoints or viewpoint animations onto the existing
one, to continue developing your animations.

10.1.1 Animation Cuts (Pauses)

Cuts in a viewpoint animation are simply points where the camera pauses for a while.
They are inserted automatically when you click Pause during the interactive recording
of a viewpoint animation, or you can insert them manually into an existing viewpoint
animation.

10.1.2 To create a viewpoint animation in real time

v/. .\-
\

1. Click Animation tab »Create panel i*Record(\_/J.
To the far right of the Animation tab, notice that the Recording panel displays.
2. Navigate around in the Scene View while Autodesk Navisworks records your
movement. You can even move the section planes through the model during
your navigation, and this will be recorded into the viewpoint animation too.

3. At any point during the navigation, click Animation tab »Recording panel *»Pause U H
This will pause the recording while you maneuver into a new position. To

continue recording the viewpoint animation, click Pause again.
The resulting viewpoint animation will contain a cut for the duration of the pause.

4. When finished, click Animation tab »Recording panel *»Stop
The animation is saved automatically in the Saved Viewpoints wmdow (click »
View tab Workspace-panel »Windows drop-down Saved
Viewpoints). Your new viewpoint animation is called “AnimationX”, where “X” is
the latest available number. The name will be editable at this point if you want to
name it yourself. This viewpoint animation will also become the current active
animation in the Available Animations drop-down list on
the Playback panel of the Animation tab.

While the above method is useful for creating quick viewpoint animations on the fly,
sometimes you need more control over the viewpoint camera. To do this in Autodesk
Navisworks, you need
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to set up several viewpoints and add them to an empty viewpoint animation.
When playing back the animation, Autodesk Navisworks will then interpolate
between these viewpoints.

10.1.3 To create an animation frame by frame

1.

If necessary, display the Saved Viewpoints window (click >
View tab Workspace-panel »Windows
drop-down Saved Viewpoints).

Right-click the Saved Viewpoints window and select Add Animation.

A new viewpoint animation is created, called “AnimationX”, where “X” is the
latest available number. The name will be editable at this point if you want to
name it yourself. There will be no plus sign next to the new viewpoint animation
because it is empty.

Navigate to a position in the model you would like to add to your animation and
save the new location as a viewpoint. (Right-click the Saved Viewpoints window
and select Save Viewpoint.) Repeat this step as desired. Each viewpoint will
become a frame for the animation. The more frames you have, the smoother
and more predictable the viewpoint animation will be. See Save Viewpoints for
more information on creating viewpoints.

When you have all required viewpoints, drag them onto the empty viewpoint
animation you just created. You can drag them on one-by-one, or you can
select multiple viewpoints using the CTRL and SHIFT keyboard keys and

drag several on atonce.

If you drop them onto the viewpoint animation icon itself, then the viewpoints will
become frames at the end of the animation, but you can drop the viewpoints
anywhere on the expanded animation to put them where you wish.

At this point, you can use the Playback Position slider on the Playback panel of
the Animation tab to move backward and forward through the viewpoint
animation to see how it looks.

You can edit any of the viewpoints inside the viewpoint animation (see Edit
Viewpoints for details on this), or you can add more viewpoints, delete them,
move them around, add cuts, and edit the animation itself until you are happy
with the viewpoint animation.

Saved Viewpoints x |

#-(J 3D View

= u Animation
@ View
1) view (1)
) view (2)
D view (3)
@ View (4)

Figure 10-1: Animation and Related Viewpoints
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Home Viewpoint Review RGUl-lschl View Output BIM 360 Render

@} O [ animaton - ofo]> w oo E E @

Animator| Record }ia‘,‘ga.’;;'_ Time 0  90:00.00 2| Enable Scripter Export
Scripts Animation
Create Playback Script Export

Figure 10-2: Playback Panel

Once you have several viewpoint animations, you can drag and drop them onto a
master viewpoint animation to compose more complex combinations of animations,
just like dragging and dropping viewpoints onto an animation as a frame.

10.2 Animating objects

%
Animation tab > Create panel » Animator

With the Animator, scenes can be created. Under those scenes, animations can be
established. A scene could be a door and the animation would be that door opening
and closing. To create an animation for a scene, select the object or set of objects to be
animated. Attach them to the animation set by right-clicking the name of that animation
set and selecting “Add Animation Set” and “From Current Selection”. Then use the
following tools to create the animation itself. To control time in the animation, use the
right side of the Animator dialog box.

o @ Puts Animator into translation mode. The Translation gizmo is
displayed in the Scene View, and enables you to modify the position of
the geometry objects. This mode remains active until you select a
different object manipulation mode from the toolbar

. .L‘ﬂ. Puts Animator into rotation mode. The Rotation gizmo is displayed in
the Scene View, and enables you to modify the rotation of the geometry
objects. This mode remains active until you select a different object
manipulation mode from the toolbar.

e i@ Puts Animator into scale mode. The Scaling gizmo is displayed in
the Scene View, and enables you to modify the size of the geometry
objects. This mode remains active until you select a different object
manipulation mode from the toolbar.

J .. Puts Animator into color mode. A color palette is shown in the
Manual Entry bar, and enables you to modify the color of the geometry
objects.

« L& puts Animator into transparency mode. A transparency slider is
shown in the Manual Entry bar, and enables you to modify the
transparency of the geometry object

o “HiTakesa snapshot of the current change to the model as a new
keyframe in the timeline view.
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o .ﬁl. Enables/disables snapping. Snapping only comes into effect
when moving objects by dragging the gizmos in the Scene View, and
has no effect on numerical entry or keyboard control.

[5‘3""- L '] Selects the active scene.

° Controls the current position of the time slider in the

timeline view.

o _.mRewinds the animation back to the beginning.
o _<]|]:Rewinds one second.

o _{J.Plays the animation backward from the end point to the start, and
thenstops. This does not alter the direction that the animated elements
fage

o |:| iPauses the animation. To continue playing, click Play again.
*  [-Stops and rewinds the animation to the beginning.

o '_|][>:Plays the animation forward from the starting point to the end.
*  [{jPlays the animation forward one second.

Fast forwards the animation to the end.

Animator

[0 @@ & @) scene 2 vfooooo | RIS 0] o5 IOI A

00100 00200 OXNCO0 OX400 00500 00800 O0XNTO0 O0XS00 0034

I _Name Active  Loop P.P. Inf'nitel
i Scenel O O O
EI Scene 2 O | O

[EIEREEIYC

Figure 14-3: Animator Dialog Box
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&.

Figure 14-4: Example Animator Rotation Gizmo

10.3 Creating a script

Click Animation tab > Scripts panel » Scripter ==.

Add a script “'. Choose how it will exist in the model by adding events & © L@@ ¢4 2@
A script will create a trigger for an animation. Scripts can be tied to hot-keys,

hotspots in the model, and more. If triggered, the animation associated with it will

play.

A script can be modified in the right side of the Scripter Dialog Box under

Properties. Click Animration tab »Scripts panel Enable Scriptsg.

This will turn on scripts and allow a user to interact with the model. For example, if there is a
script to open a door associated with pressing a specific key on the keyboard, pressing
this key will open the door.

Sarpter
Saipts Events Froperties
Name: Activ Hotspot  Sphere v
New Script Trigger when |Entering
i I
New Script (1) 5} Hotspot Type
Positon X [ofton _|v[ofton |z[ofton |t
Radius (ft) |1ft On
3062l o &
Actions
P& Ye@2FE e

Figure 14-5: Scripter Dialog Box
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11. Special topic: Rebar and Steel Connections
Collaborations

3D reinforcement (rebar) can be modelled in Revit and then export to Navisworks for clash detective.

Reinforcement must be hosted by a valid host such as structural wall, column and floor. In this section, you
will learn

e How to place reinforcement for Columns.

e How to place area reinforcement for Floors.

e How to control visibility of rebars.

e Various reinforcement settings in Revit.

e Export the model into Navisworks and check clashing

11.1  Modelling Reinforcement for Columns
1 Open from the course folder the “3D Reinforcement.rvt” file and go to Level 2 (Structural Plan).

2 Click Structure Tab » Remforcement panel > Rebar
R GHG-Q-»-Ql2-FOAI©->5|E D 7 30Rinforcement (Completed) - Struc.. keyword 68 ¥ Lsionin W @ - &FX
Architecture ~ Structure  Systems  Insert  Annotate  Analyze  Massing &Site  Collaborate  View ~Manage  Add-Ins  Modify (-
Wall ~ [l Truss { / d Area Fabric Sheet Model Text ale - Wal H.
N 4 ) ) E: I B ale = :
0 Column B Brace - €| 3 path [ Cover I8 Model Line 222 E o Vertical | 7]
Modify| Beam Connection  Isolated Wall ~ Slab |Rebar| - Component By Shaft HPGrd  Set
& Floor ~ [ Beam System - [B Fabric Area &3 Rebar Coupler - [&] Model Group *  Face £ Dormer | E

Select ~ Structure | structural Rebar Reinforcement ~ Model Opening Datum  Work Plane

Places planar, multi-planar or free form rebar

Properties KT Tl ] - A Project Browser - 3D Reinforceme... X
= | Theplaced element s a rebar instance with the properties of the Uit Il OO views@
— specified rebar type, rebar shape for shape driven rebar NI & cructural Plans
Sifjj  Structural Plan geometry. In free form rebar, the placed element maintains the Level 1
evel

rebar type and rebar geometry. In either instance, rebar wil
respect cover references and constraints when placed. L Level 1 - Analytical

Structural Plan: Level 2 v £8 Edit Ty Level 2

Graphic Displa..Edit. | | Press F1 for more help Level 2 - Analytical
Orientation  Project North I Site

Wal Join Displ...Clean all walljo I £} 3D Views

Discipline  Structural Analytical Model
Show Hidden ... By Discipline | il il 30}

Color Scheme ... Background 1 ) Elevations (Building Elevation
Color Scheme <none> il Emh

Nort

System Color . Edit.. I

ystem Color ... i 1t Il South

Default Analys... None st

Sunbath [ ] i @ L _ - — 5 = = = fL‘L - — 4 = = 7fj [ Sections (Building Section)

= T -
Underlay LJ‘ LT U] B Legends

Range: Base L.. None T Schedules/Quantities (all)
Range: Top Le... Unbounded D Sheets (all)

Underlay Orie... Look dowr 2] Families

#-[@] Groups
9 Revit Links

Extents.
Crop View O

Crop Reglon V.l
= |

Bonitalcts Apply 1:100 FE& KMEHED 0 RMIE < LA s =
Floors : Floor : Generic 300mm 0 Main Model 2 45 5 Oh M & To

3 First, place the main (longitudinal) rebars with the following settings:
e Use default 40R rebar
e Placement Plane: Near Cover Reference
e Placement Orientation: Perpendicular to Cover
e Rebar Set: (Layout: Fixed Number and Quantity: 5)

Hover over to the left side of the column at Grid-B-1 and place the rebars. Revit will show you boundary
of the cover in green dotted lines.
4 Select the rebars just created and mirror (type “MM”) them to the other side of the column.
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5 Next, place the links to the column. Click Structure Tab > Reinforcement panel > Rebar.
6 Select

e Rebar Shape: 51

e 12T rebar

e Placement Plane: Near Cover Reference

e Placement Orientation: Parallel to Cover

e Rebar Set: (Layout: Maximum Spacing and Spacing: 300mm)

\ \

|
7 Now change the view visibility of these rebars. Select all the rebars and click “Edit” in View Visibility from
the Properties Palette and make the rebars “View unobscured” and “View as solid” in 3D View {3D}. Then
click OK.
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Properties

Rebar Bar

Multiple Types Selected ™

Structural Rebar (3) o
= R~

lView Visibility ...

Structural
Reinforcement...

Dimensions
A

0.0 mm

0.0 mm

0 mm

0.0 mm

0mm

0.0 mm

0mm

0.0 mm

0.0 mm

0 mm

0.0 mm

0 mm

0.0 mm

0mm

0.0 mm

( )
( )
( )
( )
(0Omm)
( )
( )
( )
( )

0mm

DIV OIRT T OIMIMIOIN®

Properties help

Apply 1:100

Rebar Element View Visibility States

HOx XMmMEHE > ¢ (2 E <

Show rebar element unobscured and/or as a solid in 3D views (in fine level of detail).

Click on column headers to change sort order.

View Type

View Name

View unobscured

View as solid ~

3D View

Analytical Model

L]

3D View

VN

]
e

=R

Elevation

South

e

Elevation

East

Elevation

North

Elevation

West

Section

Structural Plan

Section 1

Level 1

NN

<]

Structural Plan

Level 2

Structural Plan

Level 2 - Analytical

Structural Plan

Level 1 - Analytical

Structural Plan

Site

ACIECIRET

Cancel

8 Go to 3D view and the rebars can be seen unobscured now.
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R2BG Q-0 - =-FOA G- 05 & @+ 30Riforcement Complted)-30V.. 1+ [Tpeaiomovormoe @ & fr Lsanin - W @ - & X
Architecture ~ Structure ~ Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View Manage Add-lns  Modify @+
[} Q wall - [ Truss % @7 Q =] * # Area g] £ Model Text =R zIE 2. Wall @ 6]
\ ale
{0 Column B Brace L3 Path Cover I\, Model Line e &y Vertical
Modify| Beam Connection  Isolated Wall ~Slab  Rebar Component By Shaft Set
& Floor =[] Beam System - [B Fabric Area %0 Rebar Coupler 2 [&] Model Group = face I Dormer E
Select ¥ Structure ¥ Connection ¥ ¥ Foundation Reinforcement ¥ Model Opening Datum  Work Plane
Properties x m Project Browser - 3D Reinforceme... X
10, Views (all)
@ 3D View . [} Structural Plans
Level 1
IL Level 1 - Analytical
13D View: (3D} ~ B Edit Type Level 2
SectionBox ] ~ Level 2 - Analytical
Camera i Site
Rendering Set... Edit... 43D Views
Locked Orient... Analytical Model
Perspective £
fye Flevation 254622 [} Elevations (Building Elevation
Target Elevation 4088.1 East
North
Camera Position Adjusting
s " South
Ide.nmy Data et
View Template _ <None> | [ Sections (Building Section)
View Name (3D} Legends
Dependency  Independent [ Schedules/Quantities (all)
Title on Sheet Sheets (all)
Phasing & &] Families
Phase Filter ~ Show All t-[@] Groups
Phase New Constructi... &3 Revit Links
v 5 v
Properties help Apply 1:100 FAKXGBRBEBRY 0 RMEGIE < 2 < 2

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. /7 ) B Main

Model

A 5 O O T

9 You can set the Structural Rebar Object Style and make it easier to view. (Click Manage Tab > Settings

panel > Object Styles = )

Object Styles s
Model Objects Annotation Objects Analytical Model Objects Imported Objects

Filter list:

Line Weight . . . ~
Category - Line Color | Line Pattern Material
Project... Cut

[+ Structural Conn... |1 1 |i Black Solid

- Structural Fabri... |1 1 |. Black Solid

[+ Structural Fabri... |1 1 W Black Solid

[+ Structural Foun... |2 4 W Black Solid

[+ Structural Frami... | 1 4 W Black Solid

[ Structural Path ... |1 1 B Black Solid

| Structural Rebar |5 |1 |MRed |Sold | "

=& structural Rebar.. |1 Black — sofd . T =

[H- Structural Stiffe... |1 Black Solid

[+ Structural Trusses | 1 RGB 000-12| Dash

--------- Telephone Devi... |1 Black

[+ Topography 1 M Black Solid Earth

- Walls 2 4 W Black Solid Default Wall

[+ Windows 2 Solid

[+ Wires 1 Solid

v
Modify Subcategories
SelectAll | SelectNome | | Invet

Delete Rename

| OK Cancel

| Apply
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ReBG-Q @ -8 =-20A & 02 S B> 30Reinforcement Completed) -3DV.. »[Tpearemoaorpmase  |@ & ¢ L signin W ®- - 2 X
Architecture ~ Structure  Systems  Insert  Annotate  Analyze Massing &Site  Collaborate  View  Manage = Add-lhs  Modify &~
| @sIzE p o B 3% s B3
B 0 - e 1T
Modify| Materials !?; '? a B Additional | L. Design Manage E’ Phases I‘ @  Dynamo Dynamo
@ B8 settings @®- Options | Main Model T links & Player
Select ¥ Settings Project Location Design Options Manage Project Phasing _ Selection  Inquiry Macros  Visual Programming
Properties x ; A Project Browser - 3D Reinforceme... X
4 )70, Views (all)
@ 3D View . (= Structural Plans
Level 1
Level 1 - Analytical
3D View: {30} ~ | Edit Type Level 2
SectionBox [ A Level 2 - Analytical
Camera * Site
Rendering Set.. Edit... =+ 3D Views
Locked Orient... Analytical Model
Perspective {3D}
Eye Hovation 254622 & Elevations (Building Elevatior
Target Elevation 4088.1 East
Camera Position Adjusting i
Identity Data H South
West
View Template  <None> i Sections (Building Section)
View Name  {3D} [ Legends
Dependency _Independent [ Schedules/Quantities (all)
Title on Sheet Sheets (all)
Phasing # 1] Families
Phase Filter  Show All [@] Groups
Phase |New Constructi.. &9 Revit Links
v S = s
Properties help Apply B XGRHEE R o MG IE < > < >

1:100

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. ¥ 0 B Main Model

A5 O & o

10 Next, place starter rebars. First cut a (building) Section of the column and then go to this section view.

ReEHG- Q-7 -8 2-F0A G- &7 30Reinforcement Completed) - Struc..  » [pearepwordorpmase |G & ¥% L Signin D ERRENERX
0l Achitecture  Structure  Systems  Insert  Annotate  Analyze Massing &Site  Collaborate  View  Manage  Add-ins  Modify | Views (D)~
= . T Q- 3
X Kom- 08 AP 00 = (1R
I3 2y &M M o= 8]
O Sat- &=8&- * O — OO gl b o-g
Modify - B o0 O =, ® y 2y ~ size  Split
- ¥ Gon- A Y Q i X o Crop Segment
Select ¥ Properties  Clipboard Geometry Modify View  Measure  Create Reference Crop  Section
Modify | Views
Properties x — (3 52 ~ Project Browser - 3D Reinforceme... X
=10, Views (all)
Section - ) Structural Plans
Building Section Level 1
Level 1 - Analytical
Views (1) ~ | e Edit Type P
Color Scheme ... Background ~ Level 2 - Analytical
Color Scheme Site
Default Analys... (53D Views
Sun Path Analytical Model
Extents g £
Crop View | £+ Elevations (Building Elevatior
Crop Region V... = East
: North
Annotation Cr...
Far Gl Clip without line | —, — — — N7 — = South
ar Cipping ip without line | — - —an — West
Far Clip Offset_607.6 [ Sections (Building Section)
ScopeBox  None B Legends
2 5
Identity Data [ Schedules/Quantities (all)
View Template  <None> | Sheets (all)
View Name Column RC 2] Families
Dependency Independent [ - # [@] Groups
Title on Sheet 9 Revit Links
Referencing S.
R h v
Properties help Apply 1:100 FAHK KWMEH? 0 BMIE < 2 < 2

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 17 0 M |Main Model

e R 0 Y

11 Click Structure Tab » Reinforcement panel > Rebar. Select
e Rebar Shape: 00
e Placement Methods: Sketch Rebar and select the footing
e 40R rebar
e Placement Plane: Near Cover Reference
e Placement Orientation: Parallel to Cover
e Rebar Set: (Layout: Maximum Spacing and Spacing: 300mm)

Sketch the starter rebar as shown below. Then mirror this starter rebar to the opposite face

slightly upward.
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11.2  Placing Area Reinforcement for Floors (Slabs)
1 Go to Level 2 (Structural Plan).

2 Click Structure Tab » Reinforcement panel > Area.
REHG- Q- 7- @2 -7 O0A @[5 & DB 30 Reinforcement (Completed) - Struc...  » [72e a keyword or prrase
File Architecture  Structure ~ Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View ~ Manage  Add-Ins  Modify -

N g Q wall ~ [ Truss m /07 @ e m [ Fabric Sheet @ £ Model Text == :IE = Wall @ 16}

2 &

M 8 % Lsionin W @ - &X%

Column Brace R Cover I, Model Line &y Vertical ¥ 73
R | oo 0 R SEenalAres R antoreanent o Component By Shaft #arid  set IE
S = . o
& Floor = [ Beam Sy ¢ i boundary of an area to populate with rebar Area &1 Rebar Coupler [&] Model Group *  Face £ Dormer &
Select ~ Structure inforcement Model Opening Datum  Work Plane
The finished sketch is an area reinforcement instance with up to 4
pr—— 5|[ | lavers of evenly spaced reinforcing bars for floors, walls and T T o~ e ——
slabs. M _ m LI e e
r = }777—7;7‘$77777‘77‘J— 10, Views (all) ~
/ B o
) Structural Plans
Structural Plan - | 1 1
" | - , 30 r Level 1
T | \Z 600mm | Level 1 - Analytical
. o | & edi i E===_====
Structural Plan: Level 2 8 Edit Type 1 | : = k0 I‘ Level 2
Orientation  Project North ~ i I {l é) o Level 2 - Analytical
h e )
Wall Join Displ... Clean all wall joi i il 300 x v \ Site
Discpline  Structural i [ 600pm N 4‘ £ 3D Views
Show Hidden ... By Discipline j = ® 40 ,“ Analytical Model
Color Scheme ... Background i I 30}
T e i E | () Elevations (Building Elevat
System Color . Edit ==t -c-o Eost
ERe 00 | i= Press F1 for more help i Y- "o North
Default Analys... None o . 1 N !
L / L South
Sun Path ] i i I
h . i L, i i West
Bindctlpy L _ - Sy G, P G Sy g, _ _ _ 3 _ _ Sl [ Sections (Building Section
Range: Base L.. None L_j Lgd o 5 [} Column RC
Range: Top Le... Unbounded Section 1
Underlay Orie... Lok down Section 2
Extents 5 | 7 Legends
CropView [ I Schedules/Quantities (all)
Crop Region V...[ ] Sheets (all)
Annotation Cr... [] | 5 2] Families
e i A ; v | [@] Groups v
Properties help Apply 1:100 F@& KEBMED 0 RMIE < > i< B
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. i/ 20 2| Main Model AN & M O To

3 Select the slab below the corewalls on plan. Then sketch the area of the reinforcement on plan
Rectangle as shown below.
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Layers

Top Major Dir...
Top Major Bar... 20T

Top Major Ho... {Standard Hook...
Top Major Ho... . Down

Top Major Sp... {150.0 mm

Top Major Nu... ;2

Top Minor Dir...
Top Minor Bar.... 12T
Top Minor Ho...:None

Top Minor Ho...iDown
Top Minor Sp... :300.0 mm

5 Click Finish Edit Mode ¥ to add the area reinforcement.
6 Create a (building) Section across the slab.

ReHG-Q-0- 8 2-F0OA ©- Q|5 & -~ 30 Reinforcement (Completed) - Struc.. > [Type a keyword or phrase
Architecture ~ Structure ~ Systems  Insert Annotate  Analyze Massing &Site  Collaborate  View Manage Add-lhs  Modify &~

[} g Q Wall - B Truss % & ‘@ ) . ## Area [P Fabric Sheet @ £ Model Text g gEE 2. Wall @ 6}

68 8 ¥ Lsignin =le = =S

0 column Brace 3 Path [E cover I, Model Line By Vertical 173
Modify| Beam Connection  Isolated Wall Slab  Rebar Component By Shaft HGrid  Set
£ Floor ~ [[] Beam System - B Fabric Area &1 Rebar Coupler - [@] Model Group * | Face 7 Dormer &
Select ¥ Structure 3 Connection ¥ ¥ Foundation Reinforcement ~ Model Opening Datum  Work Plane
Properties ¢ A W T I | | Lt (352 ~ Project Browser - 3D Reinforceme... X
‘ LFI> 1 : 1 1 1 1 : ‘\1 : | (=10, Views (all) A
Structural Plan - T N  — | &~ Structural Plans
| Level 1
e = Level 1 - Analytical
Structural Plan: Level 2 | 8 Edit Type | = Level 2
Graphics ) | | Level 2 - Analytical
View Scale 1:100 N | T Site
Scale Value 1 1100 I 20T @ 150 mm (T) I, 3D Views
Display Model Normal i 12T @ 300 mm (T) == Analytical Model
Detail Level  Medium [OR @300 mm (B) EW. | 30}
Parts Visibility  Show Original / | i | = Elevations (Building Elevat
Visibility/Grap. Edit.. : I Il LT bl
Graphic Displa. Edit. 'J] JL g
aphic Displa.. LGS CHE - - ] ,,,’,fi,,,d,,,,fi,,,,,,,, M i
Orientation _ Project North — L J —T T — THT r— West
Wall Join Displ... Clean all wall joi. - Sections (Building Section
Discipline Structural — Vo
Show Hidden ... By Discipline Section 1
Color Scheme ... Background | — Section 2
Color Scheme <none> Section 3
System Color ... Edit... [ Legends
Default Analys... None ‘ [ Schedules/Quantities (al)
Sun Path | Sheets (all)
P P | v @ 2] Families v
Properties help Apply 1:100 FEAK XBMEY 0 BHE < 2 I 2
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. i 0 B Main Model 5 4R R h M O To

ReEEBG- Q- -8 2-F0A @ 05 & DB~ 30Reinforcement Completed) -Secti..  » [peakemodorprase |G S ¢ L Signin W ®- - =X

Architecture ~ Structure ~ Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View Manage Add-lns  Modify @~
o @B
17

[} g Q wall - [ Truss % Q o) H#E Area [ Fabric Sheet @ /) Model Text j;'g glg F Wall

0 column Brace 3 Path [E cover I Model Line [y Vertical
Modify| Beam Connection Wall Slab  Rebar Component By Shaft Grid | Set
£ Floor ~ [[] Beam System - B Fabric Area #1 Rebar Coupler - [@] Model Group ' Face I Dormer
Select ¥ Structure ¥ Connection ¥ ¥ Foundation Reinforcement ¥ Model Opening Datum  Work Plane
Properties x ‘ 52 A Project Browser - 3D Reinforceme... X
=10, Views (all) ~
Q Section o (= Structural Plans
Building Section Level 1
Level 1 - Analytical
Section: Section 3 ~ B2 Edit Type Level 2
Hide at scales ... 1:100 ~ / Level 2 - Analytical
Discipline Structural - S Site
Show Hidden ... By Discipline { m S S £ 3D Views
Color Scheme ... Background : . . . . . . . . . ] . Analytical Model
Color Scheme ~ <none>  — o . 2 T T 30}
Default Ana[ysanone i . ’ LI - N | - . (=} Elevations (Building Elevat
Sun Path [m} Co S N Lo S A -0 Easl
5 - North
Btents . Sl
Crop View \ 3 West
Crop Region H - - Sections (Building Section
Annotation Cr... [] P - COlERRE
Far Clipping  Clip without line - " Section 1
FarClip Offset 63756 L S&ction2
ScopeBox  None - _ Section 3
\dentity Data A e 2 5 Legends
View Template <None> = =3 g ™ Schedules/Quantities (all)
View Name  Section 3 | ) g Sheets (al)
T R A q S, v . v | B Families v
Properties help Apply 1:50 DX XEEHEY 0 RME < 2 < 2
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 77 = B4 Main Model G = R

11.3  Reinforcement Settings
There are many parameters to control the reinforcement in Revit. To check/revise the setting,
Click Structure Tab » Reinforcement panel
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Rebar

% Area

J_,_a Path

Cover

B, Fabric Area #1 Rebar Coupler

[B\ Fabric Sheet

|__“,j Rebar Cover Settings
éy Reinforcement Settings

/7 Reinforcement Numbers

Reinforcement ¥

{1 Reinforcement

Rebar Cover Settings

Add, remove and modify rebar cover settings.

Description Setting
Rebar Cover 1 25.0 mm
Rebar Cover 2 40.0 mm
Rebar Cover Settings
Reinforcement Settings
Reinforcement Settings

- General Setting Value

-~ Reinforcement rounding . —

- Reinforcement presentation Slab Top - Major Direction m

Slab Top - Miner Direction m

- Path Reinforcement . . .

_ Varying Rebar Set Slab Bottom - Major Direction (B)
Slab Bottom - Minor Direction (B)
Wall Interior - Major Direction m
‘Wall Interior - Minor Direction m
Wall Exterior - Major Direction (E)
Wall Exterior - Minor Direction (E)
Each Way EW.
Each Face EF.

How do 1 edit tag abbreviations for area reinforcement? Cancel

Duplicate
Add

Delete

Help
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¢ Reinforcement

Reinforcement Numbers

Minimum number of digits for reinforcement numbers:

o
Rebar Numbers Fabric Numbers Coupler Numbers Remove Gaps
Partition
Start In Use Start In Use Start In Use
1 1-7
How do these settings affect reinforcement numbering and partitions? OK || Cancel App

Exporting the Reinforcement model to Navisworks.

Open model “Rebar Model.rvt”. Create the model with following reinforcement.

Column: T10 -150 Links, 8 x T32 Longitude bars.

Beam: T12-150 Links, 3T25 Top, 3T32 Bottom.

7o\
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Numbering
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Level 2 ~
- * - 3000 -

Level 1 ™~
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Highlight the all steel and filter it with rebar only.

AULUUEER REVIL £U10.5 ~ INUL FUI RESAIE VETSIVI = REUAH IMUUET | (WILT REUG1LIVE = U VIEW. [5U)

ucture  Systems  Insert  Annotate  Analyze  Massing &Site  Collaborate  View ~ Manage  Add-ns  Enscape™  Quantification ~ AUGmentecture  Site Designer  BIMobject®  TOOL

sboar| Fifter x| View  Measure  Create Selection

Activ|

- Category, Count:
T iructural Columns 2 Check Al

(ruclura\ Rebar 9 | Check None

eva

Total Selected I g
ctioy e oo
(all)

~ |E2 Edit Type

lew Construction
lone

Page 75
At properties, make sure to change the visibility states of bar to “solid”.



Properties

Rebar Bar

Multiple Types Selected

Structural Rebar (9)
Shape

~ | B8 Edit Type

Shape Image

<None>

Hook At Start

Hook At End

Rounding Overrides

Edit...

End Treatment At Start

None

End Treatment At End

None

Rebar Set
Layout Rule

Quantity

Spacing

T[gph'ps
View Visibility States

Edit.. 1

Structural

Reinforcement Volume |

Properties help

Apply

Rebar Element View Visibility States

Click on column headers to change sort order.

Show rebar element unobscured and/or as a solid in 3D views (in fine level of detail).

View Type View Name View unobscured View as solid

| 13D View Analytical Model [] E
{ |3D View (3D} [l

o oot B

Elevation East L]

Elevation North []

Elevation West L]

Section Section 1

Structural Plan Level 1 L]

Structural Plan Level 2 L]

Structural Plan Level 2 - Analytical L]

Structural Plan Level 1 - Analytical []

Structural Plan Site L]

oK

Cancel

Isolate the rebar with the glass icon at bottom.
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Highlight the column steel only:
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Navisworks 2018

File exporter for Navisworks 2018

Choose Navisworks settings = Revit > Export to “Selection” as shown.
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N Navisworks Options Editor - Revit X R Export sce (Not Responding)
: = @
+ Ge;ml Convert construction parts ] A Save in: ‘ Nwc 2
- Interface
- Model Convert element Ids ' Name Date modified Type
=) File Readers Convert element parameters Al v . Beam steel.nwc 16-Dec-18 11:14 PM  Navisworks Ca
= Convett element propetties [ Quiclesees column steel.nwc 16-Dec-18 11:14 PM  Navisworks Ca
Convet lights 0 - Rebars (Clashed).nwc 16-Dec-18 11:05 PM  Navisworks Ca
Ve [
‘ Rebars (Selected).nwc 16-Dec-18 11:.03 PM  Navisworks Ca
Convet lnked CAD fomats Reskiop Rebars.nwc 16-Dec-18 11:01 PM  Navisworks Ca
Convert linked files [] = Structural Frame.nwc 16-Dec-18 11:02 PM  Navisworks Ca
Convert room as attibute (] S
Libraries
Convert URLs ]
Coordinates | Project Intemal %
Divide File into Levels [ WiBFE
Export | Selection v g
Export room geometry M \ 2 Network
< >
Export... Import... _OK Cancel Help
File name: Column Steel only.nwc ~ ‘ Save
Save as type: Navisworks (*.nwc) ~ Cancel
| ‘ Navisworks settings... ‘ |

L g O B R W g

Save the file as “ Column Steel only.nwc”

Repeat the same procedure for beams:

XYY

AAAAAAAAAAAAAAN Z

“Y‘V‘V‘V‘V‘V‘V‘V‘V‘V‘V‘V"

/)

\\ YV YYYYYY YV Y Y Y N

Export to Navisworks 2018.

Save as “Beam Steel only.nwc”
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R Export scene as..

Save in: |

NWC

~

Quick access

Desktop

m
Libraries

5

This PC

&

Network
<

‘ Name

@ Beam steel.nwc

Column Steel only.nwc
- @ column steel.nwc

@ Rebars (Clashed).nwc
@ Rebars (Selected).nwc
@ Rebars.nwc

Structural Frame.nwc

@rr@E~

Date modified

16-Dec-18 11:14 PM
17-Dec-18 7:30 AM
16-Dec-18 11:14 PM
16-Dec-18 11:05 PM
16-Dec-18 11:03 PM
16-Dec-18 11:01 PM
16-Dec-18 11:02 PM

Type

Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca

File name: ‘Beam Steel only.nwc

Save as type: ‘iNavisworks (*.nwc)

Navisworks settings...

Reset temporary Hide / Isolate.

| Save |

i Cancel |

Apply Hide/Isolate to View

| Reset Temporary Hide/Isolate

Isolate Category

Hide Category
Isolate Element

Hide Element

RGN ¢ B & e <

You can also isolate the column and beam elements with the same method.
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Filter
Category: Count:
tructural Columns p
tructural Framing (Girder) 1
[ [Structural Rebar 9
Total Selected Items: 3
' Cancel

Check All

Check None

Apply

Export and Save it as “Structure Frame.nwc”

0@y

Date modified

17-Dec-18 7:32 AM
16-Dec-18 11:14 PM
17-Dec-18 7:30 AM
16-Dec-18 11:14 PM
16-Dec-18 11:05 PM
16-Dec-18 11:03 PM
16-Dec-18 11:01 PM
16-Dec-18 11:02 PM

Type
Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca
Navisworks Ca

>

Save

Cancel

R Export scene as...
Savein: | | NWC
* Name -
. N] Beam Steel only.nwc
QUicklaccess Beam steel.nwc
- I Column Steel only.nwe
- column steel.nwc
D
ESEOp Rebars (Clashed).nwc
'n Rebars (Selected).nwc
o Rebars.nwc
Libraries -
Structural Frame.nwc
This PC
Network
<
File name: |Struc1ural Frame.nwc
Save as type: Navisworks (*.nwc)
Navisworks settings...
nalytical

Model

Iding Elevation)

ing Section)
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Open Navisworks Manage 2018.

At top Menu,choose Home, then Append.

Il Viewpoint  Review  Animati

! e 3

Append Reset Select
* All... *

Put on the structure Frame.nwc first.
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@ Autodesk Navisworks Manage 2018 (NOT FOR RESALE)  Untitled
G Viewpoint Review  Animation View Output BIM 360 Render o -

D&- é}l Lvrl r\p ['\Y & 1= L?“,Fmdr‘(ems, LD_‘ P E

Append  Refresh Reset  File Select Select | . Selection ;A - ; Unhide | Links  Quick Properties
7 All.. Options - All Tree [D]Se“ ML) All Properties
Project ¥ Select & Search ¥ Visibility Display

Append the Column steel and beam steel as well.

Filter the steel by choosing “Column Steel only.nwc” and “Beam Steel only.nwc” all then “Hide Unselected”:

Page 83



Autodesk Navisworks Manage 2018 (NOT FOR RESALE) Untitled
: Viewpoint Output BIM 360
: &2 (T™] L\§ [’:| i QN E’ 3 Find Items cad i Al @!@ =
El &z Ll L ‘U E;/LI \ H’\F ik Firdd ~ I— v L - 0 &
Unhidev Links  Quick

— Hide Requi
All Properti
Disp

Render

View

Review  Animation

i

Lo

Hide
Unselected

- [(b sets v

Al Options Selection Al Same | Tree
Select & Search ¥

Append  Refresh Reset  File Select | save  Select  Select |Selection

Project ~

Standard 2

Structural Frame.nwc

IEEIColumn Steel only.nwd|
ElBeam Steel only.nwd]

Press Escape few times.
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On menu, press Clash detective and Add Test:
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Autodesk Navisworks Manage 2018 (NOT FOR RESALE)  Untitled
LI Viewpoint  Review  Animation  View Output BIM 360  Render [

El [@_’J @ E L\§ LDL& E @ Find Items F\ (’/5 T}J ;% \va] \}» = B Appe

ek Find - v 5= RN
) Quick Find Q@ B Batch
Append Refresh Reset_ File || Select Select _ [selection| = Unhide | Links  Quick meLiner Quantification Autodesk Animator Scripter
" All.. Options - Al e |[@ses ~|| & All Properties i Rendering
Project ~ Select & Search ¥ Visibility Display Tools
| Clash Detective - > | Selection Tree s

) Standard v
There are currently no clash tests defined. Raddrest | By || Standed ¥

Structural Frame.nwc

8 Column Steel only.nwe
Report sBBeam Steel only.nwd
~Selection A Selection B
Standard Standard
@~ 'Structural Frame.nwc @-'Structural Frame.nwc
=B Column Steel only.nwc @B Column Steel only.nwc
sBBeam Steel only.nwc =B Beam Steel only.nwc

Enter “Rebar Clashing
Clash Detective @ %

Test 1 Last Run: <None>
Clashes - Total: 0 (Open: 0 Closed: 0)

Name Status Clashes I New Active Reviewed Approved

oo ol S

[ [ Add Test J l Reset All Compact All | Delete All J ll?" Update All J & -

Rulec Select Recnltc Rannrt

Choose Selection A — Column Steel only

Choose Selection B — Beam Steel only
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[F Add Test | | Reset All Compact All | Delete All ‘ | [T Update All
Rules Select | Results | Report
~Selection A ~Selection B
|SIandard b | |Slandard >

Structural Frame.nwc

Column Steel only.nwc

Beam Steel only.nwc

Select the Type of clash as “Hard Clash”

=)

-

EREIE

Structural Frame.nwc
Column Steel only.nwc

Beam Steel only.nwc

b%] (=&

b | Tlerance: 0.000 m

~Settings
Type: |Hard
Link: | None

“l Step (sec): 0.1

[«] Composite Object Clashing

Run Test

Result follow the following settings:
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[«/] Composite Object Clashing

Clashes are highlighted.

Page 88

Rules Select | Results | Report
[ *jNew Group | [+ |[ _," [ ‘ ‘ & Assign ‘ ﬁ.Da‘None b [E‘:ﬁ +_é] [e Re-run Test]
Name ;‘ Status Found Approved... Approve| | _Highlighting >
=)
[tem1 & [ em2 || €
=
| Use item colors e | w
=
[] Highlight all clashes 2
w
~Isolation
[Dim Other r Hide Other]
/| Transparent dimming
[«] Auto reveal
~Viewpoint
| Auto-update v |
[«] Animate transitions
l Focus on Clash ’
~Simulation
[«] Show simulation
~View in Context
Al v |
{ View ]
Press “Run Test”
| |
b ¥ | ;h b ¥ | ;h
]| | DE || & (&) | (DX |8 |
~Settings
Type: |Hard d | Tolerance: | 0.000 m
Run Test
Link: |N0ne V| Step (sec): 0.1 S_te




Clash Detective

IE

#+ Rebar Clashing

Last Run: Monday, December 17, 2018 7:42:35 AM
Clashes - Total: 6 (Open: 6 Closed: 0)

Name

- Rebar Clashing

<

Status Clashes

I New I Active

I Reviewed

IApproved

N O RN XN A N 11

Examine the above clashes and then

Report can be formed as Viewpoint / HTML (Tabular)

[«] Auto reveal

/| Transparent dimming

[ [F Add Test ] [ Reset All Compact All | Delete All ] | [ Update All
Rules Select | Results | Report
[ *jNew Group [n"n] 11 ‘ \ ‘QK Assign |, ‘ ﬁh‘NOI"Ie he @ %_f_!\,‘ Ie Re-run Test
Name [ ] Status Found Approved... Approve|  _Highlighting >
. =)
Clash The met... [l 07:42:35 17-12-2018 [tem1 @ [ tem2 ||| €
25
® Clash? New v 07:42:35 17-12-2018 [Useitemeaiors v || |5
| o
® Clash3 New v (07:42:3517-12-2018 I:I Highlight all clashes %E
o
® Clash4 New v 07:42:3517-12-2018
~Isolation
® Clash5 New v 07:42:3517-12-2018
[ Dim Otherr Hide Other l
® Clashe New v 07:42:3517-12-2018

~Viewpoint

‘ Auto-update

4 l

[«/] Animate transitions

[ Focus on Clash ]

~Simulation

[v] show simulation

~View in Context

LAl

]

[ View

l
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[ E-Add Test ] [ Reset All

Compact All

Delete All ] |;--“

Rules Select Results

Report

~Contents

[«] summary
[« Clash Point

[«/] Date Found
[+] Assigned To
[] Date Approved
[«] Approved By
|z| Layer Name
[] ttem Path

[«] ttem 1D

[] status

[] Distance

[] Description

[v] comments

[«] Quick Properties
@ Image

[«] simulation Dates
[«] Simulation Event
[«] Clash Group

[« Grid Location

~Include Clashes
For Clash Groups, include:
Group Headers Only

[] Include only filtered results

Include these statuses:

|2| New
[«] Active

[«] Reviewed

[«] Approved
[«] Resolved

~Output Settings

Report Type

Current test

Report Format
\ As viewpoints v Write Report

XML
HTML

Report in Viewpoints:

HTML (Tabular)
Text

As viewpoints G
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Saved Viewpoints

3 3D View
+3 3D View (Column Steel only.nwc)
4102 3D View (Beam Steel only.nwc)
-0 Rebar Clashing

(D Reset Appearance

(D Clash1

D Clash2

- Clash3

(D Clash4

101 Clash5

- Clash6

Report in HTML:
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AUTODESK
NAVISWORKS'

Clash Report

Tolerance‘clashes New‘Active

Rebar Clashing

0 0 0 \H'arrdi old i

Steel Connections:

In Revit 2018, there is a library of Steel Connection components to help you model the connection between

0000m| 6 [ 6] 0
Item 1 Item 2
image Ciash Name Status Distance Description Date Found Ciash Point item iD Layer item Name item Type item iD Layer item Namejitem Type
.Cashl New -0.005 Hard 2018/12/16 23:42x:-6.313, y:-1.195, 2:2.369 Element ID: 352979 <No level>Rebar Bar Solid Element ID: 353891 <No level>Rebar Bar Solid
. New -0.004 Hard 2018/12/16 23:42x:1.325,y:-0.917, 2:2.518 Element ID: 352981 <No level>Rebar Bar Solid Element ID: 353891 <No level>Rebar Bar Solid
.Cash3 New -0.002 Hard 2018/12/16 23:42x:-5.778, y:-0.936, 2:2.239 Element ID: 352979 <No level>Rebar Bar Solid Element ID: 354029 <No level>Rebar Bar Solid
. New -0.002 Hard 2018/12/16 23:42x:0.785, y:-1.203, z:2.237 Element ID: 352981 <No level>Rebar Bar Solid Element ID: 354029 <No level>Rebar Bar Solid
.CashS New -0.001 Hard 2018/12/16 23:42x:-6.290, y:-1.191, 2:2.250 Element ID: 353054 <No level>Rebar Bar Solid Element ID: 354029 <No level>Rebar Bar Solid
.CashG New -0.001 Hard 2018/12/16 23:42x:-5.797, y:-1.191, 2:2.252 Element ID: 353151 <No level>Rebar Bar Solid Element ID: 354029 <No level>Rebar Bar Solid

steel members. You will learn how to install and load them for use in a project. Two of the connections will
be used as examples to demonstrate this powerful tool.

12.1 Install and Load Steel Connections

1 Open Autodesk Desktop App from your Window Toolbars.

Autodesk Desktop App

Links

2 Scroll down until you find the Revit 2018 Steel Connections and click “Update” to install.
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v Autodesk® Steel Connections for Revit® 2018

3 After installation, open from the course folder the “Steel Connections.rvt” file.

4 Click Manage Tab » Settings panel » Connection Settings to load steel connection components.
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(*Alternately, you can open Connection Settings by clicking on the little arrow at the bottom right of the



Connection panel in Structure Tab.)
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5 You can see there are many steel connection components such as “Base Plate” and “Column Beam
Seat Angle”.

Scroll down the list of Available Connections and find “Splice joint”. Select it and click “Add”. Then click

“OK” and the connection component “Splice joint” is loaded into the project.
Structural Connection Settings X

Connections Parameters

Connection Group:

All Connections &7
Available Connections: Loaded Connections:
EStiffened seated beam connection ~ Splice joint

EBeam Seat T
tMament connection
E:Moment flange plates
leoment flange T
;Post double beam
QIEApex Haunch
IFront plate splice
ﬂ]tDouble apex haunch

}ECranked beam to beam

]ﬂ{ Moment column splice

ECIip angle <-- Remove
Edip angle - Skewed
=y 7

All None

Je 94

OK Cancel Help

12.2. Create a Splice Joint (joining two steel beams)



1 Go to 3D view and click Structure Tab » Connection panel > Connection and select “Spice joint” from

the Type Selector in Properties Palette.
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2 Select the two steel beams as shown below. (Hold down “ctrl” key while se
press “spacebar” and a splice joint is added to join the selected beams.

lecting the beams.) Then
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3 Zoom in to see the splice joint just added.

. Note that Steel
. Connection can only be
| seen when the detail level

g Ea

4 Select the splice joint and click “Edit” to modify the detail of this joint. Notice the number “2” on the left
beam. This indicates that it is the “2.beam” in this joint configuration.
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5 From the “Web” menu, select “Web plates” and set

e Plate alignment: “centered 1.Beam”
e Distance web plate from top: “0”

e Type of connection: “both bolted”
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The splice joint will be updated automatically as you enter the changes.
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Note the little diagram with annotation to help you understand what parameter you are changing.
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6 Next, from the “Flange Top” menu, select “Flange plates top” and change “Type of connection” to “both
bolted”. Then select “Bolts flange top” and change both “Number of Columns 1.beam” and “Number of

Columns 2.beam” to “2”.

Note the “Same for bottom” option. Uncheck it if you want the joint setting for top and bottom flanges to

be independent of each other.
ReHG K-

@ 2P O A - O[3 - T Steel Connections (Completed) - 3D Vi.. b [7ype a keyword or phrase

Modify | Structural Connections

= @)v

08 8 ¥ Asignin

-

& X

= @K% A

v
>

Architecture ~ Structure  Systems  Insert  Annotate  Analyze  Massing &Site  Collaborate  View ~ Manage  Add-Ins
D X Ken 00 P A ip=ec 9 fe] B
D St~ ‘&= 8- = ¢ og n g =
Modit S oo e BB T IOHS AR
= ¥ Gon- L& T OQ X & 89 Parameters
Select ¥ Properties  Clipboard Geometry Modify View  Measure  Creaste  Connection
Modify | Structural Connections
Properties. X Project Browser - Ste... X
=0, Views (all)
< ] - Structural Plans
plice joint -
Level 1
Level 1 - Analy
Structural Connections ( | £ Edit Type
T N Splice Joint -
Approval Status None Properties o ——— (Z’
Modify Paramet.. g o
odify Paramet . S General Y | 1. Diameter Sinch v
Input Elements | UBAS7x191x89, . T 5
= - " /el e Bolt Type A325 i
Dingessions ~ Flange Top 2 | Bolt Grade 109 v
Yolime Bol Assemb Naw
Flange plates t olt Assembly a 5
Structural Analysis G SRR
Code Checking .. Not Calculated Bolts flange top 2. Number of Columns Loeam —~ [2
i ¥ Bolt columns flang...
Identity Data . N e =
Image = Inner flange plates...
& 3. Number of Columns 2beam ~ [2
Comments =_Bolt rows flange
Mark 5 flange Bottom v | 201 staaser 2eam =
Phasing fleg 4. Number of Rows 1
Phase Created  New Construction |5 [@ Type of bolt's connection alste v
Phase Demolish... None -
Properties help
Properties help Apply 15K 5 R 4 03 W0 LR A O e <
Click to select, TAB for alternates, CTRL ad: \ 0 B Main Model

S U LSV

7 You can create a callout of the joint from the north elevation of the model. Then annotate the callout for

drawing production.
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7.5.3 Create Gusset Plate joints for Bracings
1 Go to 3D view and turn on the Connection Settings by clicking the little arrow in the Connection panel
(Structure Tab).
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“Gusset plate for 2 diagonals” and click “Add”. Click “OK” to load these connections into the project.
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2 Click Structure Tab » Connection panel > Connection and select “Gusset plate at one diagonal” from
the Type Selector in Properties Palette.
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3 Select the left brace and the column as shown below. (Hold down “ctrl” key while selecting.) Then press

ﬂate joint is added to join the selected brace to the column.
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4 Create another gusset plate joint for the right brace.
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5 Now, click Structure Tab » Connection panel > Connection and select “Gusset plate for 2 diagonals”
from the Type Selector in Properties Palette.

Select the two braces and the horizontal beam (Hold down “ctrl” key while selecting). Then press
“spacebar” and a gusset plate joint is added to join the selected braces to the column.
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects. /7 ) B Main Model

You can select any steel connections created and click “Edit” to modify the details of the joints.
changing the setting of the joints so that they look like the details shown below.

[E) 3D View: {3D} - Steel Connections (Completed)
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Exporting the Model to Navisworks and collaborations.

Elevation: South - Steel Connections (Completed)
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